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XfreeTM COVID-19 Direct RT-PCR
Extraction-Free - Multi-Platform

PROPRIETARY NAME

�8�N�g�I�ITM COVID-19 Direct RT-PCR

INTENDED USE

The BioGX �8�N�g�I�ITM COVID-19 Direct RT-PCR (“�8�N�g�I�ITM COVID-19”) is a real-time RT-PCR test
intended for the qualitative detection of nucleic acid from the SARS-CoV-2 virus in specimens
collected in Copan UTMD†/VTM, Copan ESwabTM, or saline using nasopharyngeal, nasal,
mid-turbinate, and oropharyngeal swab, or nasopharyngeal wash/aspirates or nasal aspirates
obtained from individuals suspected of COVID-19 by their healthcare provider. Testing has been
validated for analysis of: a.) direct addition of individual patient sample, b.) extracted nucleic acid
addition of individual patient sample and c.) direct addition of pooled patient sample. Within the
United States, the BioGX �8�N�g�I�ITM COVID-19 kit is limited to laboratories certified under the
Clinical Laboratory Improvement Amendments of 1988 (CLIA), 42 U.S.C. §263a, that meet
requirements to perform high complexity tests.

Results are for the identification of SARS-CoV-2 RNA. The SARS-CoV-2 RNA is generally detectable
in nasopharyngeal, nasal, mid-turbinate, and oropharyngeal swab specimens, nasopharyngeal
wash/aspirates or nasal aspirates during the acute phase of infection.

Positive results are indicative of the presence of SARS-CoV-2 RNA; clinical correlation with
patient history and other diagnostic information is necessary to determine patient infection
status. Positive results do not rule out bacterial infection or co-infection with other viruses. The
agent detected may not be the definite cause of the disease. Negative results do not preclude
SARS-CoV-2 infection and should not be used as the sole basis for patient management
decisions. Negative results must be combined with clinical observations, patient history, and
epidemiological information. Laboratories within the United States and its territories are
required to report all results to the appropriate public health authorities.

The BioGX �8�N�g�I�ITM COVID-19 is intended for use by qualified and trained clinical laboratory
personnel specifically instructed and trained in the techniques of real-time PCR �Q�[�p�Q�j�g�]
diagnostic procedures and use of the Applied Biosystems QuantStudioTM 5 (Design & Analysis
software version 1.5.1 or later), Applied Biosystems 7500 Fast Dx (SDS software version 1.4 or
later), Bio-Rad CFX96 TouchTM or CFX384 TouchTM (Maestro software version 1.1 or later)
platforms. The BioGX �8�N�g�I�ITM COVID-19 product has been validated for use with direct patient
sample addition to the rehydrated master mix or for use with extracted nucleic acid using Qiagen
Viral RNA Mini Kit.

Applied Biosystems QuantStudio 5 trademark is the property of ThermoFisher Scientific.
Bio-Rad CFX96 Touch and Bio-Rad CFX384 Touch trademarks are the property of Bio-Rad Laboratories.

SUMMARY AND EXPLANATION
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Severe Acute Respiratory Syndrome Coronavirus 2 (SARS-CoV-2) is the novel betacoronavirus
that causes the COVID-19 respiratory disease. The COVID-19 respiratory disease is transmitted
amongst infected humans within populations via respiratory droplets from talking, coughing, and
sneezing1,2. Symptoms of COVID-19 range from mild illness (dry cough, fatigue, fever, and
shortness of breath) to severe illness and death1.

COVID-19 was first identified on December 31, 2019, amongst patients suffering from pneumonia
in Wuhan, China1,2. SARS-CoV-2 is the seventh coronavirus identified as a human pathogen that
likely evolved within an animal host or within humans following zoonotic transfer3

.

As of September 29, 2020, the WHO has confirmed 33,034,598 infections and 996,342 COVID-19
related deaths globally2. The elderly, immunocompromised, and those with cardiovascular
disease, diabetes, and chronic respiratory disease have been shown to be at higher risk for
severe illness1,2. Ahead of global vaccination efforts, patient testing and social distancing
measures mandated by world governments have proven to be the only way to stem transmission
rates.

BioGX �8�N�g�I�ITM COVID-19 utilizes primer and probe sets based on the United States Centers for
Disease Control and Prevention (US CDC) assay for specific detection of SARS-CoV-2 (N1 gene
region) and human RNase P4,5,6 that serves as an endogenous Sample Processing Control.
Additionally, a non-naturally occurring single-stranded RNA has been integrated into the
lyophilized format to serve as an internal amplification control.

The multiplex PCR assay is provided in BioGX Sample-ReadyTM lyophilized format within 4 x 2 mL
vials. Each vial contains all PCR components such as primers, probes, enzymes, dNTPs, MgCl2,
Internal Amplification Control RNA (IAC), and buffers required for real-time RT-PCR-based testing.

Individual Patient Samples

BioGX �8�N�g�I�ITM COVID-19 kit supports testing of individual patient samples of 104 direct patient
samples or 160 extracted/purified nucleic acid samples. Direct and extracted patient samples
analysis has been validated with the following platforms:

-Applied Biosystems QuantStudioTM 5 utilizing Design & Analysis software version 1.5.1 or later.
-Applied Biosystems 7500 Fast Dx utilizing SDS software version 1.4.1.
-Bio-Rad CFX96 TouchTM utilizing Maestro software version 1.1 or later
-Bio-Rad CFX384 TouchTM utilizing Maestro software version 1.1 or later

Pooled Patient Samples

BioGX �8�N�g�I�ITM COVID-19 supports testing of 52 pooled samples (52 x 5 patient sample pools per
PCR reaction). Pooled sample analysis has been validated with the following platforms:

-Applied Biosystems QuantStudioTM 5 utilizing Design & Analysis software version 1.5.1 or later.
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-Bio-Rad CFX96 TouchTM utilizing Maestro software version 1.1 or later

Validated Nasopharyngeal and Oropharyngeal Specimen Collection Devices

The following sample types have been validated for Individual and pooled direct patient sample
addition:

�” Specimen Collections in:
-Copan ESwabTM

-Copan Universal Transport Media (UTMD†)
-BDTM Universal Viral Transport (UVT)
-Viral Transport Media (VTM)
-Dry swab (resuspended in saline)
-Saline

The following sample types have been validated for nucleic acid extracted individual sample
addition:

�” Specimen collections in:
-Copan ESwabTM

-Copan Universal Transport Media (UTMD†)
-BDTM Universal Viral Transport (UVT)
-Viral Transport Media (VTM)
-Dry swab (resuspended in saline)
-Saline

PRINCIPLES OF THE PROCEDURE

The BioGX �8�N�g�I�ITM COVID-19 is to be used with the Applied Biosystems QuantStudioTM 5, Applied
Biosystems 7500 Fast Dx, Bio-Rad CFX96 TouchTM or Bio-Rad CFX384 TouchTM platforms with
direct patient sample or extracted patient sample. The template RNA is reverse transcribed into
cDNA and target sequences are PCR amplified. The amplified target(s) is (are) detected during
amplification using hydrolysis probes labeled at one end with a fluorescent reporter dye
(fluorophore) and at the other end with a quencher moiety. Probes labeled with different
fluorophores are used to detect specific amplicons originating from SARS CoV-2 (N1), RNase P,
and Internal Amplification Control in the following optical channels:

�” RNase P FAM equivalent channel
�” unused HEX equivalent channel
�” SARS-CoV-2 (N1) Texas Red equivalent channel
�” Internal Amplification Control Cy 5 equivalent channel
�” unused Cy 5.5 equivalent channel
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When the probes are in their native state, the fluorescence of the fluorophore is quenched due
to its proximity to the quencher. However, in the presence of their specific target cDNA, the
probes hybridize to their complementary sequences and are then hydrolyzed by the 5’-3’
exonuclease activity of the DNA polymerase as it synthesizes the nascent strand along the cDNA
template. As a result, the fluorophores are separated from their quencher molecules and
fluorescence is emitted. The amount of fluorescence detected in the three optical channels used
for the BioGX �8�N�g�I�ITM COVID-19 is directly proportional to the quantity of the corresponding
probe that is hydrolyzed, and therefore generally proportional to the amount of synthesized
target. The Applied Biosystems QuantStudioTM 5, Applied Biosystems 7500 Fast Dx, Bio-Rad
CFX96 TouchTM or Bio-Rad CFX384 TouchTM platforms measure these signals at the end of each
amplification cycle in real time and interpret the data to provide a qualitative result for each of
the above targets. A positive result for the detection of target RNA is indicated by the presence
of a real-time PCR growth curve and an associated Ct (Cycle threshold) value.

REAGENTS

Qty REF Contents No. Tests
Direct
Format

No. Tests
Extracted
Format

No. Tests
Pooled
Format

1 500-003-XMP BioGX XfreeTM COVID-19 Direct
RT-PCR

Extraction-Free - Multi-Platform
Sample-ReadyTM lyophilized PCR
Master Mix containing polymerase,
reverse transcriptase, primers, probes,
dNTPs, MgCl2, Internal Amplification
Control RNA (IAC), and buffers

104 160 52

NOTE: Safety Data Sheets (SDS) are available at www.biogx.com or by request.
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EQUIPMENT AND MATERIALS REQUIRED BUT NOT PROVIDED

�” RNA Control (External Control):
o BioGX Synthetic Nucleocapsid Phosphoprotein Gene Region (N1)

(catalog no. 720-0206).
�” BioGX Molecular Grade Water or equivalent.

o BioGX Rehydration Water Part number: 800-0035-12
�” Sterile swab collection device appropriate for nasal, nasopharyngeal or oropharyngeal

swab collections.
�” Copan universal transport media (UTMD†) collection kit.
�” Copan ESwabTM collection kit.
�” BDTM universal viral transport (UVT) collection kit.
�” Sterile viral transport media (VTM).
�” Sterile saline (0.85% NaCl).
�” Vortex Genie 2 Vortexer (VWR catalog no. 58815-234) or equivalent.
�” Disposable nitrile gloves.
�” Optional if using extraction: Qiagen Viral RNA Mini Kit (REF 52906).
�” Applied Biosystems QuantStudio 5 (0.2 mL) consumables.

o Thermo Fisher optical 8-tube strip (catalog no. 4316567)
o Thermo Fisher ultra-clear optical caps, strips of 8 (catalog no. AB-0866)
o Thermo Fisher 96-well optical clear reaction plates (catalog no. A36924)
o Thermo Fisher 96-well qPCR plate seals (catalog no. AB-1170)

�” Applied Biosystems 7500 Fast Dx (0.1 mL) consumables.
o Thermo Fisher optical 8-tube strip (catalog no. 4358293)
o Thermo Fisher ultra-clear optical caps, strips of 8 (catalog no. 4323032)
o Thermo Fisher 96-well optical reaction plates (catalog no. 4346906)
o Thermo Fisher 96-well qPCR plate seals (catalog no. 4311971)

�” Bio-Rad CFX96 Touch consumables.
o Bio-Rad 8-tube PCR strips without caps (catalog no. TLS0851)
o Bio-Rad Optical flat 8-cap strips for PCR tubes (catalog no. TCS0803)
o Bio-Rad 96-well plates (catalog no. HSP9655)
o Bio-Rad 96-well plate sealing film, optical (catalog no. MSB1001)

�” Bio-Rad CFX384 Touch consumables.
o Bio-Rad 384-well plates (catalog no. HSP3905)
o Bio-Rad 384-well plate sealing film, optical (catalog no. MSB1001)

�3�D�J�H�� �R�I���� �����������������; �0�3�����&�(�����5�H�Y�������������$�3�5��������



XfreeTM COVID-19 Direct RT-PCR
Extraction-Free - Multi-Platform

WARNINGS AND PRECAUTIONS

�” Treat all biological specimens as if capable of transmitting infectious agents in
accordance with safe laboratory procedures such as those described in CLSI
Document M297 and in Biosafety in Microbiological and Biomedical Laboratories8.

�” Performance characteristics of this test have been established only with the
specimen types listed in “Intended Use” section. The performance of this assay with
other specimen types or samples has not been evaluated.

�” Do not use the reagents if the protective pouches are open or torn upon arrival.
�” Close reagent protective pouches promptly with the zip seal after each use. Remove

any excess air in the pouches prior to sealing and store at 2-8 °C.
�” Do not remove desiccant from the PCR master mix pouches.
�” Do not use master mix if the desiccant is not present or is broken inside the

pouches.
�” Do not use reagent vials if they are opened or damaged.
�” Do not mix reagents from different pouches and/or kits and/or lots.
�” Do not use expired reagents and/or materials.
�” Do not pipette by mouth.
�” Do not smoke, drink, or eat in areas where specimens or kits are being handled.
�” Dispose of unused reagents and waste in accordance with country, federal,

provincial, state, and local regulations.
�” Clean and disinfect all surfaces with a 10% bleach solution followed by molecular

grade water.
�” Use clean gloves when handling PCR reagents.

STORAGE AND STABILITY

�” BioGX recommends long-term storage at 2-8°C. Product is stable when shipped for
under 5 days at ambient temperature.

�” Reagents have been tested to demonstrate optimal performance when stored
properly at 2-8°C and consumed by the expiration date on the kit label.

�” Avoid exposing the reagents (lyophilized or rehydrated) to direct sunlight or
long-term ambient lighting.

�” Store unused rehydrated master mix up to 24 hours at 2-8°C, protected from light.

�” If pouched is opened by the user but lyophilized reagent is not rehydrated, avoid
exposure of lyophilized reagent to moisture and use the entire contents of the
opened pouch within 1 month.
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INSTRUCTIONS FOR USE

Instrument Templates/Protocols and Programming

Applied Biosystems QuantStudioTM 5
(Operating software: Design & Analysis Software v1.5.1 or later)

Install the BioGX Protocol on the Applied Biosystems QuantStudioTM 5
It will be necessary to import the Applied Biosystems QuantStudioTM 5 template. The most
current Applied Biosystems QuantStudioTM 5 template is available for download at
www.biogx.com. Follow the “Education Center” tab in the navigation menu at the top of the
home page. Select "Int. Product Documents". Follow the "�8�N�g�I�ITM Direct RT-PCR Documents" tab.
Choose the appropriate product number and follow the "Run Files" link to the platform of
choice. Download the Applied Biosystems QuantStudioTM 5 template. Alternatively, the Applied
Biosystems QuantStudioTM 5 template can also be obtained by emailing BioGX at eu@biogx.com.
To manually program the thermocycler, please refer to Appendix A. For further instrument
information, please refer to the Applied Biosystems QuantStudioTM 5 user manual9.

Applied Biosystems 7500 Fast Dx
(Operating software: SDS Software v1.4.1)

Install the BioGX Protocol on the Applied Biosystems 7500 Fast Dx
It will be necessary to import the Applied Biosystems 7500 Fast Dx template. The most current
Applied Biosystems 7500 Fast Dx template is available for download at www.biogx.com. Follow
the "Education Center" tab in the navigation menu at the top of the home page. Select "Int.
Product Documents". Follow the "�8�N�g�I�ITM Direct RT-PCR Documents" tab. Choose the appropriate
product number and follow the "Run Files" link to the platform of choice. Download the Applied
Biosystems 7500 Fast Dx template. Alternatively, the Applied Biosystems 7500 Fast Dx template
can also be obtained by emailing BioGX at eu@biogx.com. To manually program the
thermocycler, please refer to Appendix B. For further instrument information, please refer to the
Applied Biosystems 7500 Fast Dx user manual10.

Bio-Rad CFX96 TouchTM

(Operating software: MaestroTM 1.1 or later)

Install the BioGX Protocol on the Bio-Rad CFX96 TouchTM

It will be necessary to import the Bio-Rad CFX96 TouchTM Protocol and Plate files. The most
current versions of the Bio-Rad CFX96 TouchTM Protocol and Plate files are available for download
on www.biogx.com. Follow the "Education Center" tab in the navigation menu at the top of the
home page. Select "US Product Documents". Follow the "�8�N�g�I�ITM Direct RT-PCR Documents" tab.
Choose the appropriate product number and follow the "Run Files" link to the platform of
choice. Download the Bio-Rad CFX96 TouchTM Protocol and Plate files. Alternatively, the Bio-Rad
CFX96 TouchTM Protocol and Plate files can also be obtained by emailing BioGX at
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eu@biogx.com. To manually program the thermocycler, please refer to Appendix C. For further
instrument information, please refer to the Bio-Rad CFX96 TouchTM user manual11.

Bio-Rad CFX384 TouchTM

(Operating software: MaestroTM 1.1 or later)

Install the BioGX Protocol on the Bio-Rad CFX384 TouchTM

It will be necessary to import the Bio-Rad CFX384 TouchTM Protocol and Plate files. The most
current versions of the Bio-Rad CFX384 TouchTM Protocol and Plate files are available for
download on www.biogx.com. Follow the "Education Center" tab in the navigation menu at the
top of the home page. Select "US Product Documents". Follow the "�8�N�g�I�ITM Direct RT-PCR
Documents" tab. Choose the appropriate product number and follow the "Run Files" link to the
platform of choice. Download the Bio-Rad CFX384 TouchTM Protocol and Plate files. Alternatively,
the Bio-Rad CFX384 TouchTM Protocol and Plate files can also be obtained by emailing BioGX at
eu@biogx.com. To manually program the thermocycler, please refer to Appendix D. For further
instrument information, please refer to the Bio-Rad CFX384 TouchTM user manual11.

SPECIMEN PREPARATION

Direct Individual Patient Sample Addition
Pipette 5 μL of patient sample directly to tube/well containing RT-PCR master mix.

Validated sample types include nasopharyngeal, nasal, mid-turbinate, and oropharyngeal swabs
collected in 1 or 3 mL collection media (i.e. Copan ESwabTM, Copan UTMD†, UVT, VTM or saline).
Additional validated sample types include nasopharyngeal wash/aspirates or nasal aspirate
collected in saline.

Follow the “RT-PCR Set-up - Direct Patient Sample” section below for the appropriate real-time
PCR platform (i.e. QuantStudioTM 5, 7500 Fast Dx, CFX96 TouchTM and CFX384 TouchTM).

Extracted Individual Patient Sample Addition
Pipette 5 μL of purified nucleic acid eluate directly to tube/well containing RT-PCR master mix.

Validated sample types extracted with Qiagen Viral RNA Mini Kit include nasopharyngeal, nasal,
mid-turbinate, and oropharyngeal swabs collected in 1 or 3 mL collection media (i.e. Copan
ESwabTM, Copan UTMD†, UVT, VTM or saline). Additional validated sample types include
nasopharyngeal wash/aspirates or nasal aspirate collected in saline.

Follow the “RT-PCR Set-up - Extracted Patient Sample” section below for the appropriate
real-time PCR platform (i.e. QuantStudioTM 5, 7500 Fast Dx, CFX96 TouchTM and CFX384 TouchTM).
For validated magnetic bead or silica column nucleic acid extraction method, pipette appropriate
volume of specimen into the extraction tube/plate and proceed with protocol as per
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manufacturer’s instructions for use. After extraction and elution, add 5 µL of the eluate to
RT-PCR master mix.

Pooled Direct Patient Sample Addition
Pipette 5 μL of pooled patient sample directly to the tube/well containing RT-PCR master mix.

Validated sample types include nasopharyngeal, nasal, mid-turbinate, and oropharyngeal swabs
collected in 1 or 3 mL collection media (i.e. Copan ESwabTM, Copan UTMD†, UVT, VTM or saline).
Additional validated sample types include nasopharyngeal wash/aspirates or nasal aspirate
collected in saline.

Follow the “RT-PCR Set-up - Pooled Direct Patient Sample” section below for the appropriate
real-time PCR platform (i.e. QuantStudioTM 5 or CFX96 TouchTM).

Other Sample Types

This assay has been optimized for use with the specimen types and volumes
described above. Use of any other specimen type, collection method, or sample
volume may be inhibitory to the PCR. BioGX does not make claims for processing
methods or sample types other than those described in this manual.

RT-PCR SET-UP - DIRECT PATIENT SAMPLE

Applied Biosystems QuantStudioTM 5

1. Wear nitrile gloves when handling Sample-ReadyTM lyophilized reagents to
reduce the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX �8�N�g�I�ITM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 26 samples to be tested by direct sample addition.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix cannot be used immediately, it
can be capped and stored up to 24 hours at 2-8°C, protected from light).

5. Transfer 15 μL of rehydrated master mix to the bottom of 26 empty wells
(8-tube PCR strips or 96-well PCR plate).

6. To each well containing 15 μL of rehydrated master mix, add 5 μL of direct
patient sample.

7. Affix the appropriate optical caps or optical plate seals.
8. Pulse spin the sealed PCR plate or tube to mix and bring liquid to the bottom.
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9. Load 8-tube PCR strips and/or 96-well PCR plates into the real-time PCR platform
and start run. Avoid unnecessary delay once tubes/plates are loaded.

10. Refer to Table 2 for result interpretation.

Note: For Applied Biosystems QuantStudioTM 5 template file for Direct Patient Sample
addition (500003XMPDirectQS5v2.edt), please refer to the section: “Instrument
Templates and Programming”: Install the BioGX Protocol on the Applied Biosystems
QuantStudioTM 5 for download instructions. To manually program the thermocycler,
please refer to Appendix A.

RT-PCR SET-UP - DIRECT PATIENT SAMPLE

Applied Biosystems 7500 Fast Dx

1. Wear nitrile gloves when handling Sample-ReadyTM lyophilized reagents to
reduce the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX �8�N�g�I�ITM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 26 samples to be tested by direct sample addition.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix cannot be used immediately, it
can be capped and stored up to 24 hours at 2-8°C, protected from light).

5. Transfer 15 μL of rehydrated master mix to the bottom of 26 empty wells
(8-tube PCR strips or 96-well PCR plate).

6. To each well containing 15 μL of rehydrated master mix, add 5 μL of direct
patient sample.

7. Affix the appropriate optical caps or optical plate seals.
8. Pulse spin the sealed PCR plate or tube to mix and bring liquid to the bottom.
9. Load 8-tube PCR strips and/or 96-well PCR plates into the real-time PCR platform

and start run. Avoid unnecessary delay once tubes/plates are loaded.
10. Refer to Table 2 for result interpretation.

Note: For Applied Biosystems 7500 Fast Dx template file for Direct Patient Sample
addition (500003XMPDirect7500Dx.sdt), please refer to the section: “Instrument
Templates and Programming”: Install the BioGX Protocol on the Applied Biosystems
7500 Fast Dx for download instructions. To manually program the thermocycler, please
refer to Appendix B.

RT-PCR SET-UP - DIRECT PATIENT SAMPLE
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Bio-Rad CFX96 TouchTM

1. Wear nitrile gloves when handling Sample-ReadyTM lyophilized reagents to
reduce the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX �8�N�g�I�ITM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 26 samples to be tested by direct sample addition.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix cannot be used immediately, it
can be capped and stored up to 24 hours at 2-8°C, protected from light).

5. Transfer 15 μL of rehydrated master mix to the bottom of 26 empty wells
(8-tube PCR strips or 96-well PCR plate).

6. To each well containing 15 μL of rehydrated master mix, add 5 μL of direct
patient sample.

7. Affix the appropriate optical caps or optical plate seals.
8. Pulse spin the sealed PCR plate or tube to mix and bring liquid to the bottom.
9. When CFX96 TouchTM run is completed, threshold setting update will need to be

completed as follows:
a. Open the “Data Analysis” window for your specific run
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel

and Quasar 670-channel and be sure “FAM” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure
only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for FAM will apply to the experiment.

c. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel
and Quasar 670-channel and be sure “CalRed 610” is checked (Note:
Threshold adjustments can be performed only in single threshold mode,
be sure only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for CalRed 610 will apply to the

experiment
d. To apply threshold settings for Quasar 670-channel, uncheck

FAM-channel and CalRed 610-channel and be sure “Quasar 670” is
checked (Note: Threshold adjustments can be performed only in single
threshold mode, be sure only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”

�3�D�J�H���� �R�I���� �����������������; �0�3�����&�(�����5�H�Y�������������$�3�5��������



XfreeTM COVID-19 Direct RT-PCR
Extraction-Free - Multi-Platform

ii. At the bottom of the popup window under “single threshold”, select
“User Defined” and enter “500”

iii. Click “OK” and the threshold for Quasar 670 will apply to the
experiment

10. Refer to Table 2 for result interpretation.

Note: For Bio-Rad CFX96 TouchTM protocol and plate files for Direct Patient Sample
addition (500003XMPDirectCFX96v2.prcl and 500003XMPDirect_plateCFX96v2.pltd),
please refer to the section: “Instrument Templates and Programming”: Install the
BioGX Protocol on the Bio-Rad CFX96 TouchTM for download instructions. To manually
program the thermocycler, please refer to Appendix C.

RT-PCR SET-UP - DIRECT PATIENT SAMPLE

Bio-Rad CFX384 TouchTM

1. Wear nitrile gloves when handling Sample-ReadyTM lyophilized reagents to
reduce the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 384-well PCR plates.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX �8�N�g�I�ITM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 26 samples to be tested by direct sample addition.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix cannot be used immediately, it
can be capped and stored up to 24 hours at 2-8°C, protected from light).

5. Transfer 15 μL of rehydrated master mix to the bottom of 26 empty wells
(384-well PCR plate).

6. To each well containing 15 μL of rehydrated master mix, add 5 μL of direct
patient sample.

7. Affix the appropriate optical caps or optical plate seals.
8. Pulse spin the sealed PCR plate or tube to mix and bring liquid to the bottom.
9. When CFX384 TouchTM run is completed, threshold setting update will need to be

completed as follows:
a. Open the “Data Analysis” window for your specific run
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel

and Quasar 670-channel and be sure “FAM” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure
only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for FAM will apply to the experiment.
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d. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel
and Quasar 670-channel and be sure “CalRed 610” is checked (Note:
Threshold adjustments can be performed only in single threshold mode,
be sure only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “250”
iii. Click “OK” and the threshold for CalRed 610 will apply to the

experiment
e. To apply threshold settings for Quasar 670-channel, uncheck

FAM-channel and CalRed 610-channel and be sure “Quasar 670” is
checked (Note: Threshold adjustments can be performed only in single
threshold mode, be sure only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for Quasar 670 will apply to the

experiment
10. Refer to Table 2 for result interpretation.

Note: For Bio-Rad CFX384 TouchTM protocol and plate files for Direct Patient Sample
addition (500003XMPDirectCFX384.prcl and 500003XMPDirect_plateCFX384.pltd),
please refer to the section: “Instrument Templates and Programming”: Install the
BioGX Protocol on the Bio-Rad CFX384 TouchTM for download instructions. To manually
program the thermocycler, please refer to Appendix D.

RT-PCR SET-UP - EXTRACTED PATIENT SAMPLE

Applied Biosystems QuantStudioTM 5

1. Wear nitrile gloves when handling Sample-ReadyTM lyophilized reagents to
reduce the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX �8�N�g�I�ITM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 40 samples to be tested using purified nucleic acid samples.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix cannot be used immediately, it
can be capped and stored up to 24 hours at 2-8°C, protected from light).

5. Transfer 10 μL of rehydrated master mix to the bottom of 40 empty wells
(8-tube PCR strips or 96-well PCR plate).
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6. To each well containing 10 μL of rehydrated master mix, add 5 μL of extracted
patient sample.

7. Affix the appropriate optical caps or optical plate seals.
8. Pulse spin the sealed PCR plate or tube to mix and bring liquid to the bottom.
9. Load 8-tube PCR strips and/or 96-well PCR plates into the real-time PCR platform

and start run. Avoid unnecessary delay once tubes/plates are loaded.
10. Refer to Table 2 for result interpretation.

Note: For Applied Biosystems QuantStudioTM 5 template file for Extracted Patient Sample
addition (500003XMPExtractQS5v2.edt), please refer to the section: “Instrument
Templates and Programming”: Install the BioGX Protocol on the Applied Biosystems
QuantStudioTM 5 for download instructions. To manually program the thermocycler,
please refer to Appendix A.

RT-PCR SET-UP - EXTRACTED PATIENT SAMPLE

Applied Biosystems 7500 Fast Dx

1. Wear nitrile gloves when handling Sample-ReadyTM lyophilized reagents to
reduce the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX �8�N�g�I�ITM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 40 samples to be tested using purified nucleic acid samples.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix cannot be used immediately, it
can be capped and stored up to 24 hours at 2-8°C, protected from light).

5. Transfer 10 μL of rehydrated master mix to the bottom of 40 empty wells
(8-tube PCR strips or 96-well PCR plate).

6. To each well containing 10 μL of rehydrated master mix, add 5 μL of extracted
patient sample.

7. Affix the appropriate optical caps or optical plate seals.
8. Pulse spin the sealed PCR plate or tube to mix and bring liquid to the bottom.
9. Load 8-tube PCR strips and/or 96-well PCR plates into the real-time PCR platform

and start run. Avoid unnecessary delay once tubes/plates are loaded.
10. Refer to Table 2 for result interpretation.

Note: For Applied Biosystems 7500 Fast Dx template file for Extracted Patient Sample
addition (500003XMPExtract7500Dx.sdt), please refer to the section: “Instrument
Templates and Programming”: Install the BioGX Protocol on the Applied Biosystems
7500 Fast Dx for download instructions. To manually program the thermocycler, please
refer to Appendix B.

�3�D�J�H���� �R�I���� �����������������; �0�3�����&�(�����5�H�Y�������������$�3�5��������



XfreeTM COVID-19 Direct RT-PCR
Extraction-Free - Multi-Platform

RT-PCR SET-UP - EXTRACTED PATIENT SAMPLE

Bio-Rad CFX96 TouchTM

1. Wear nitrile gloves when handling Sample-ReadyTM lyophilized reagents to reduce
the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX �8�N�g�I�ITM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 40 samples to be tested using purified nucleic acid samples.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix cannot be used immediately, it
can be capped and stored up to 24 hours at 2-8°C, protected from light).

5. Transfer 10 μL of rehydrated master mix to the bottom of 40 empty wells (8-tube
PCR strips or 96-well PCR plate).

6. To each well containing 10 μL of rehydrated master mix, add 5 μL of extracted
patient sample.

7. Affix the appropriate optical caps or optical plate seals.
8. Pulse spin the sealed PCR plate or tube to mix and bring liquid to the bottom.
9. When CFX96 TouchTM run is completed, threshold setting update will need to be

completed as follows:
a. Open the “Data Analysis” window for your specific run
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel

and Quasar 670-channel and be sure “FAM” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure only
one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for FAM will apply to the experiment.

c. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel
and Quasar 670-channel and be sure “CalRed 610” is checked (Note:
Threshold adjustments can be performed only in single threshold mode,
be sure only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for CalRed 610 will apply to the

experiment
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d. To apply threshold settings for Quasar 670-channel, uncheck FAM-channel
and CalRed 610-channel and be sure “Quasar 670” is checked (Note:
Threshold adjustments can be performed only in single threshold mode,
be sure only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for Quasar 670 will apply to the

experiment
10. Refer to Table 2 for result interpretation.

Note: For Bio-Rad CFX96 TouchTM protocol and plate files for Extracted Patient Sample
addition (500003XMPExtractCFX96v2.prcl and 500003XMPExtract_plateCFX96v2.pltd),
please refer to the section: “Instrument Templates and Programming”: Install the BioGX
Protocol on the Bio-Rad CFX96 TouchTM for download instructions. To manually program
the thermocycler, please refer to Appendix C.

RT-PCR SET-UP - EXTRACTED PATIENT SAMPLE

Bio-Rad CFX384 TouchTM

1. Wear nitrile gloves when handling Sample-ReadyTM lyophilized reagents to
reduce the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 384-well PCR plates.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX �8�N�g�I�ITM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 40 samples to be tested using purified nucleic acid samples.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix cannot be used immediately, it
can be capped and stored up to 24 hours at 2-8°C, protected from light).

5. Transfer 10 μL of rehydrated master mix to the bottom of 40 empty wells
(384-well PCR plate).

6. To each well containing 10 μL of rehydrated master mix, add 5 μL of direct
patient sample.

7. Affix the appropriate optical caps or optical plate seals.
8. Pulse spin the sealed PCR plate or tube to mix and bring liquid to the bottom.
9. When CFX384 TouchTM run is completed, threshold setting update will need to be

completed as follows:
a. Open the “Data Analysis” window for your specific run
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel

and Quasar 670-channel and be sure “FAM” is checked (Note: Threshold
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adjustments can be performed only in single threshold mode, be sure
only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for FAM will apply to the experiment.

c. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel
and Quasar 670-channel and be sure “CalRed 610” is checked (Note:
Threshold adjustments can be performed only in single threshold mode,
be sure only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “250”
iii. Click “OK” and the threshold for CalRed 610 will apply to the

experiment
d. To apply threshold settings for Quasar 670-channel, uncheck

FAM-channel and CalRed 610-channel and be sure “Quasar 670” is
checked (Note: Threshold adjustments can be performed only in single
threshold mode, be sure only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for Quasar 670 will apply to the

experiment
10. Refer to Table 2 for result interpretation.

Note: For Bio-Rad CFX384 TouchTM protocol and plate files for Extracted Patient Sample
addition (500003XMPExtractCFX384.prcl and 500003XMPExtract_plateCFX384.pltd),
please refer to the section: “Instrument Templates and Programming”: Install the
BioGX Protocol on the Bio-Rad CFX96 TouchTM for download instructions. To manually
program the thermocycler, please refer to Appendix D.

�3�D�J�H���� �R�I���� �����������������; �0�3�����&�(�����5�H�Y�������������$�3�5��������



XfreeTM COVID-19 Direct RT-PCR
Extraction-Free - Multi-Platform

RT-PCR SET-UP - POOLED DIRECT PATIENT SAMPLE

Applied Biosystems QuantStudioTM 5

1. Wear nitrile gloves when handling Sample-ReadyTM lyophilized reagents to
reduce the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates.
3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of

lyophilized BioGX �8�N�g�I�ITM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 13 pooled samples (each pooled sample consisting of 5
individual patient samples) to be tested by direct sample addition.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix cannot be used immediately, it
can be capped and stored up to 24 hours at 2-8°C, protected from light).

5. Transfer 30 μL of rehydrated master mix to the bottom of 13 empty wells
(8-tube PCR strips or 96-well PCR plate).

6. Prepare one pool of 5 patient samples by transferring a minimum of 50 μL of
each patient sample into an empty sterile tube. Mix by gently pipetting up and
down.

7. To each well containing 30 μL of rehydrated master mix, add 10 μL of pooled
direct patient sample.

8. Affix the appropriate optical caps or optical plate seals.
9. Pulse spin the sealed PCR plate or tube to mix and bring liquid to the bottom.
10. Load 8-tube PCR strips and/or 96-well PCR plates into the real-time PCR platform

and start run. Avoid unnecessary delay once tubes/plates are loaded.
11. Refer to Table 2 for result interpretation.

Note: For Applied Biosystems QuantStudioTM 5 template file for Pooled Direct Patient
Sample addition (500003XMPDirectPooledQS5Rev01.edt), please refer to the section:
“Instrument Templates and Programming”: Install the BioGX Protocol on the Applied
Biosystems QuantStudioTM 5 for download instructions. To manually program the
thermocycler, please refer to Appendix A.

RT-PCR SET-UP - POOLED DIRECT PATIENT SAMPLE

Bio-Rad CFX96 TouchTM

1. Wear nitrile gloves when handling Sample-ReadyTM lyophilized reagents to
reduce the generation of static charges. DO NOT use latex gloves.

2. Prepare the appropriate number of 8-tube PCR strips or 96-well PCR plates.
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3. Using 1000 μL pipet tip, transfer 400 μL of molecular grade water to one vial of
lyophilized BioGX �8�N�g�I�ITM COVID-19 reagents. The rehydrated master mix is more
than sufficient for 13 pooled samples (each pooled sample consisting of 5
individual patient samples) to be tested by direct sample addition.

4. Mix by gently pipetting up and down with 1000 μL pipet tip. (IMPORTANT: Keep
rehydrated master mix in a cold block or on ice if set-up cannot be completed
within 20 minutes. If the rehydrated master mix cannot be used immediately, it
can be capped and stored up to 24 hours at 2-8°C, protected from light).

5. Transfer 30 μL of rehydrated master mix to the bottom of 13 empty wells
(8-tube PCR strips or 96-well PCR plate).

6. Prepare a pool of 5 patient samples by transferring a minimum of 50 μL of each
patient sample into an empty sterile tube. Mix by gently pipetting up and down.

7. To each well containing 30 μL of rehydrated master mix, add 10 μL of direct
patient sample.

8. Affix the appropriate optical caps or optical plate seals.
9. Pulse spin the sealed PCR plate or tube to mix and bring liquid to the bottom.
10. When CFX96 TouchTM run is completed, threshold setting update will need to be

completed as follows:
a. Open the “Data Analysis” window for your specific run
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel

and Quasar 670-channel and be sure “FAM” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure
only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for FAM will apply to the experiment.

c. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel
and Quasar 670-channel and be sure “CalRed 610” is checked (Note:
Threshold adjustments can be performed only in single threshold mode,
be sure only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
iii. Click “OK” and the threshold for CalRed 610 will apply to the

experiment
d. To apply threshold settings for Quasar 670-channel, uncheck

FAM-channel and CalRed 610-channel and be sure “Quasar 670” is
checked (Note: Threshold adjustments can be performed only in single
threshold mode, be sure only one dye is selected)
i. Navigate to “Settings” and select “Baseline Threshold”
ii. At the bottom of the popup window under “single threshold”, select

“User Defined” and enter “500”
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iii. Click “OK” and the threshold for Quasar 670 will apply to the
experiment

11. Refer to Table 2 for result interpretation.

Note: For Bio-Rad CFX96 TouchTM protocol and plate files for Pooled Direct Patient
Sample addition (500003XMPDirectPooledCFX96Rev01.prcl and
500003XMPDirectPooledCFX96PlateRev01.pltd), please refer to the section:
“Instrument Templates and Programming”: Install the BioGX Protocol on the Bio-Rad
CFX96 TouchTM for download instructions. To manually program the thermocycler, please
refer to Appendix C.

QUALITY CONTROL

Each BioGX �8�N�g�I�ITM COVID-19 includes molecular primers and probes specific for the
detection of the endogenous extraction control, human RNase P gene. A non-naturally
occurring single-stranded RNA integrated into the lyophilized reagent serves as a PCR
internal amplification control (IAC). No external addition of Sample Processing Control
(SPC) or Internal Amplification Control (IAC) is required.

Laboratories must establish the number, type, and frequency of testing of control materials
according to guidelines or requirements of local, provincial, state, and federal and/or country
regulations or accreditation organizations in order to monitor the effectiveness of the entire
analytical process. FDA generally recommends appropriate positive and negative controls be run
with every sample extraction/PCR run. For general quality control guidance, the user may wish to
refer to CLSI MM312 and EP1213. The External Positive Control is intended to monitor for
substantial reagent failure. The External Negative Control is intended to detect reagent or
environmental contamination (or carry-over) by target nucleic acids.

The External Control available from BioGX (BioGX Synthetic Nucleocapsid Phosphoprotein gene
region (N1) (BioGX catalog no. 720-0206) is treated as if it were a patient sample (Refer to Table
1 in the “Results Interpretation” section for the interpretation of External Control assay results).
It is recommended that one (1) External Positive Control and one (1) External Negative Control
be included with each run of patient samples. BioGX recommends that the External Negative
Control be prepared prior to the External Positive Control in order to reduce the potential for
contamination as a result of control preparation.
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Preparation of BioGX External Controls

Positive Control [BioGX SARS-CoV-2 (N1)] - Each lyophilized template bead should be rehydrated
with 100 μL of molecular grade water and mixed by pipetting up and down 5 times. Add 5 μL of
the positive control to (1) well position containing dispensed master mix.

Negative Control (No Template) - Addition of 5 μL of molecular grade water to (1) well position
containing dispensed master mix.

All External Controls should yield the expected results (Table 1). An External Negative Control
that yields a positive result is indicative of errant sample handling and/or contamination. An
External Positive Control that yields a negative result is indicative of a specimen
handling/preparation problem. Review the specimen handling/preparation technique.

An External Control that yields an Unresolved, Indeterminate, or Incomplete test result is
indicative of a reagent or a real-time PCR system failure. Check the Applied Biosystems
QuantStudioTM 5 or Bio-Rad CFX96 TouchTM platforms for any error messages. Refer to the
“Troubleshooting” section of the Applied QuantStudioTM 59, Applied 7500 Fast Dx10, Bio-Rad
CFX96 TouchTM/CFX384 TouchTM 11 Instruction Manuals for interpretation of warning and error
codes. If the problem persists, use reagents from an unopened pouch or use a new assay kit.

For further reference, please reference the product insert for Lyophilized Control Template
Beads (BioGX Product Number Series 720-XXXX) which is available for download at
www.biogx.com by using the drop down menu at the top right of the home page. Select
"Education Center" then select "Int. Product Documents". Choose the appropriate product
number under "Template Controls".

Table 1. Interpretation of BioGX external controls.

Control
Type

Applicability
for Monitoring

N1
Gene

N1
Expected

Ct
RNase P

RNase P
Expected

Ct
IAC

IAC
Expected Ct

Negative
Control -

Addition of
5 µL Water

Reagent and/or
environmental
contamination

-
Not

Detected
-

Not
Detected

+ 24 ± 1.5

N1 Positive
Control -

BioGX
Synthetic
Template
Control

Substantial
reagent failure

including
primer and

probe integrity

+ 28±1.5 -
Not

Detected
+

24 ± 1.5

�3�D�J�H���� �R�I���� �����������������; �0�3�����&�(�����5�H�Y�������������$�3�5��������



XfreeTM COVID-19 Direct RT-PCR
Extraction-Free - Multi-Platform

RESULTS INTERPRETATION

Applied Biosystems QuantStudioTM 5

Results are available under the “Results” tab in the QuantStudio Design and Analysis
Software. To download the data, the user can navigate to “Export” tab and export the
data in a variety of formats (*.xls, *.xlsx, and *.txt). Alternatively, the user can navigate to
“Print report” under “File” tab to preview and save the report in *.PDF format. Please
refer to the QuantStudioTM 5 user manual for further instructions9.

Applied Biosystems 7500 Fast Dx

Results are available under the “Results” tab in the SDS Software. To download the data,
the user can navigate to “File” then click “Export”. Choose “Results”, select a desired file
name to save, and check both boxes on the “Export Settings” pop-up to export the results
as a .csv. Alternatively, the user can save a PDF of the run report by navigating to the
“Report“ section of the “Results” tab and selecting the print icon. Please refer to the 7500
Fast Dx user manual for further instructions10.

Bio-Rad CFX96 TouchTM

Results are available to view and download in pdf format by navigating to the “Tools” tab
and selecting the “Report” option on the Bio-Rad CFX MaestroTM software in Data
Analysis mode. Alternatively, the user can navigate to the “Export” tab and export all raw
data sheets in a variety of formats (*.xls, *.xlsx, and *.txt). Please refer to the Bio-Rad
CFX96 TouchTM user manual for further instructions11.

Bio-Rad CFX384 TouchTM

Results are available to view and download in pdf format by navigating to the “Tools” tab
and selecting the “Report” option on the Bio-Rad CFX MaestroTM software in Data
Analysis mode. Alternatively, the user can navigate to the “Export” tab and export all raw
data sheets in a variety of formats (*.xls, *.xlsx, and *.txt). Please refer to the Bio-Rad
CFX384 TouchTM user manual for further instructions11.

Examination and Interpretation of Patient Specimen Results

Assessment of clinical specimen test results should be performed after the external positive and
negative controls have been examined and determined to be valid and acceptable. If the controls
are not valid, the patient results cannot be interpreted. The list of expected results is outlined in
Table 2. If results are obtained that do not follow these guidelines, re-test sample or re-extract
and re-test the sample if using extraction. If repeat testing yields similar results, collect a fresh
sample from the patient for testing. In the presence of a high concentration positive result for
the target, the IAC may or may not amplify. This is normal. A positive test result does not
necessarily indicate the presence of viable infectious organisms. A positive result is indicative of
the presence of target nucleic acid. A negative test result does not preclude the presence of
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infectious organisms and should not be used as the sole basis for treatment or other patient
management decisions.

REPEAT TESTING FOR INSTRUMENT FAILURE

In case of instrument failure, repeat testing can be performed by setting up a new run using the
original sample/specimen as described above in the “Specimen Preparation” section.

Table 2. Interpretation of patient sample results14.

XfreeTM COVID-19
Direct RT-PCR

Results

N1 gene RNase P IAC
Result

InterpretationDetect
(+/-)

Expected
Ct

Detect
(+/-)

Expected Ct
Detect
(+/-)

Expected
Ct

SARS-CoV-2
POSITIVE

+ Detected + Ct�”36 +/- Ct�”30
Report as
POSITIVE

SARS-CoV-2
NEGATIVE

-
Not

Detected
+ Ct�”36 + Ct�”30

Report as
NEGATIVE

Indeterminant -
Not

Detected
- / Ct�•36 -/Ct�•36 + Ct�”30 Repeat Test*

Indeterminant -
Not

Detected
+ Ct�”36 - / Ct�•30 - / Ct�•30 Repeat Test*

*Repeat the test by preparing a new test from the remaining patient sample collection and ensure the patient sample and PCR
master mix is dispensed properly in the well being analyzed. Repeat testing must yield RNaseP and IAC detection without N1
detection to confirm a NEGATIVE result. However, if the same result is obtained upon a repeat test, report results as
INCONCLUSIVE and request a new sample collection.

LIMITATIONS OF THE PROCEDURE

�” Laboratories should include a statement such as ‘the test has been validated but FDA’s
independent review of this validation is pending’ in patient test reports to their
healthcare providers.

�” This device is not designed as the sole means of diagnosis of infectious disease. By the
inherent nature of the technology used for nucleic acid extraction and detection, nucleic
acid can be detected from dead organisms. The Intended Use is limited to the detection
of the presence of the nucleic acid signature of an organism, and not the diagnosis of
disease or disease state.

�” This product is intended for use with specimens collected using specimen collection and
transport devices listed in the “Equipment and Materials Required But Not Provided”
section.

LIMITATIONS OF THE PROCEDURE (continued)

�” Incorrect test results may occur from improper specimen collection, handling or storage,
technical error, sample mix-up, or because the number of organisms in the specimen is
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below the analytical sensitivity of the test. Careful compliance with the BioGX �8�N�g�I�ITM

COVID-19 instructions for use and the real-time PCR platforms (ie. Applied Biosystems
QuantStudioTM 59, Applied Biosystems 7500 Fast Dx10, Bio-Rad CFX96 TouchTM/CFX384
TouchTM 11) are necessary to avoid erroneous results.

�” Good laboratory technique is essential for the proper performance of this assay. Due to
the high analytical sensitivity of this test, extreme care should be taken to preserve the
purity of all materials and reagents.

�” A positive test result does not necessarily indicate the presence of viable infectious
organisms. A positive result is indicative of the presence of target nucleic acid. A negative
test result does not preclude the presence of infectious organisms and should not be
used as the sole basis for treatment or other patient management decisions.

�” As with all PCR-based �Q�[�p�Q�j�g�]diagnostic tests, extremely low levels of target below the
limit of detection of the assay may be detected, but such results may not be
reproducible.

�” False negative results may occur due to loss of nucleic acid from inadequate collection,
transport or storage of specimens, or due to inadequate cell lysis and/or extraction. The
RNase P and IAC targets have been added to the test to aid in the identification of
properly collected specimens, specimens that contain inhibitors to PCR amplification, and
as a control for reagent integrity and of the assay system as a whole.

�” The BioGX �8�N�g�I�ITM COVID-19 results may sometimes be Unresolved or Indeterminate due
to a lack of RNase P and/or IAC detection. Instrument failure could also contribute to an
incomplete run result and require retesting that can lead to a delay obtaining final
results.

�” Mutations or polymorphisms in primer- or probe-binding regions may affect detection of
new or unknown SARS-CoV-2 variants resulting in a false negative result with the BioGX
�8�N�g�I�ITM COVID-19.

�” The BioGX �8�N�g�I�ITM COVID-19 requires the use of three (3) optical channels on the Applied
Biosystems QuantStudioTM 5, Applied Biosystems 7500 Fast Dx, Bio-Rad CFX96 TouchTM or
Bio-Rad CFX384 TouchTM platforms.

PERFORMANCE CHARACTERISTICS

Analytical Sensitivity - Direct Patient Sample
Limit of Detection (LoD) was determined by serially diluting quantified inactivated SARS-CoV-2
(USA-WA1/2020; Zeptometrix catalog number NATSARS(CoV2)-ST) into negative NP swabs
samples in Copan UTMD†/VTM, Saline, and Copan ESwabTM transport media. The LoD
confirmation for each collection device (i.e. saline, Copan ESwabTM, or Copan UTMD†/VTM) were
confirmed by reliably detecting the number of inactivated SARS-CoV-2 viruses/mL in �•95% of the
samples tested. LoD confirmation was performed using the following real-time PCR platforms:
Applied Biosystems QuantStudioTM 5, Applied Biosystems 7500 Fast Dx, Bio-Rad CFX96 TouchTM

and Bio-Rad CFX384 TouchTM. The LoD for the assay using Direct patient samples on the validated
platforms ranged from 1,000 - 3,000 copies/mL (Table 3).

Table 3. LoD confirmation of direct addition of contrived samples using SARS-CoV-2 USA-WA1/2020.
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Instrument Transport Media
Concentration
[Copies/ mL]

N1-gene RNase P IAC

Agreement with
Expected Result

(% Positive)
Mean Ct Mean Ct Mean Ct

QuantStudioTM 5

UTMD†/VTM 1000 19/20 (95%) 35.1 30.0 24.1

Saline 1000 19/20 (95%) 34.2 31.4 24.4

ESwabTM 3000 20/20 (100%) 34.1 29.2 25.4

7500 Fast Dx

UTMD†/VTM 1000 20/20 (100%) 34.6 30.6 26.4

Saline 1000 20/20 (100%) 35.3 30.8 26.2

ESwabTM 2000 20/20 (100%) 34.6 28.8 28.1

CFX96 TouchTM

UTMD†/VTM 1500 19/20 (95%) 36.4 30.4 27.4

Saline 1500 20/20 (100%) 35.6 33.2 27.9

ESwabTM 1500 19/20 (95%) 35.9 30.1 28.3

CFX384 TouchTM

UTMD†/VTM 1000 19/20 (95%) 36.3 31.2 27.2

Saline 2000 20/20 (100%) 36.6 32.9 27.5

ESwabTM 3000 20/20 (100%) 36.1 28.6 29.0

Analytical Sensitivity - Extracted Patient Sample
Limit of Detection (LoD) was determined by serially diluting quantified inactivated SARS-CoV-2
(USA-WA1/2020; Zeptometrix catalog number NATSARS(CoV2)-ST) into negative NP swabs
samples in the respective transport media types (i.e. saline, Copan ESwabTM, or Copan
UTMD†/VTM) extracted with Qiagen Viral RNA Mini Kit. The LoD confirmation for each collection
device was confirmed by reliably detecting the number of inactivated SARS-CoV-2 viruses/mL in
�•95% of the samples tested. LoD confirmation was performed using the following real-time PCR
platforms: Applied Biosystems QuantStudioTM 5, Applied Biosystems 7500 Fast Dx, Bio-Rad CFX96
TouchTM and Bio-Rad CFX384 TouchTM. The LoD for the assay using Extracted Patient Samples on
the validated platforms ranged from 125 - 500 copies/mL (Table 4).
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Table 4. LoD confirmation of extracted* contrived samples using SARS-CoV-2 USA-WA1/2020.

Instrument Transport Media
Concentration
[Copies/ mL]

N1-gene RNase P IAC

Agreement with
Expected Result

(% Positive)
Mean Ct Mean Ct Mean Ct

QuantStudioTM 5

UTMD†/VTM 250 20/20 (100%) 33.9 25.5 23.5

Saline 250 20/20 (100%) 34.6 29.3 23.5

ESwabTM 500 19/20 (95%) 35.2 28.2 23.5

7500 Fast Dx

UTMD†/VTM 125 19/20 (95%) 35.2 28.4 26.1

Saline 250 19/20 (95%) 34.7 29.2 26.1

ESwabTM 250 19/20 (95%) 35.3 27.1 26.0

CFX96 TouchTM

UTMD†/VTM 250 20/20 (100%) 35.8 25.7 26.7

Saline 250 20/20 (100%) 36.0 29.5 26.9

ESwabTM 250 19/20 (95%) 36.3 27.1 26.8

CFX384 TouchTM

UTMD†/VTM 500 20/20 (200%) 36.7 26.9 26.5

Saline 500 20/20 (100%) 36.5 29.6 26.4

ESwabTM 500 20/20 (100%) 36.9 29.5 26.6

*Qiagen Viral RNA Mini extraction kit used according to manufacturer recommendations (i.e. 140µL sample processed and eluted

in 50µL).

Analytical Sensitivity - Pooled Direct Patient Sample
Limit of Detection (LoD) was determined by serially diluting quantified inactivated SARS-CoV-2
(USA-WA1/2020; Zeptometrix catalog number NATSARS(CoV2)-ST) into negative NP swabs
samples collected in the respective transport media types (i.e. saline, Copan ESwabTM or Copan
UTMD†/VTM). To create contrived 5 patient pools for each transport media, four individual
negative NP swab samples were pooled and combined with a fifth sample that was spiked with a
defined concentration of quantified SARS-CoV-2 virus. The LoD confirmation for pooled samples
in each respective collection device was confirmed by reliably detecting the number of
inactivated SARS-CoV-2 viruses/mL in �•95% of the samples tested. LoD confirmation was
performed using the following real-time PCR platforms: Applied Biosystems QuantStudioTM 5 and
Bio-Rad CFX96 TouchTM. The LoD for the assay using Pooled Direct Patient Samples on the
validated platforms ranged from 3,000 - 6,000 copies/mL (Table 5).
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Table 5. LoD confirmation of pooled contrived samples using SARS-CoV-2 USA-WA1/2020.

Instrument Transport Media
Concentration
[Copies/ mL]

N1-gene RNase P IAC

Agreement with
Expected Result

(% Positive)
Mean Ct Mean Ct Mean Ct

QuantStudioTM 5

UTMD†/VTM 4,000 20/20 (100%) 34.55 30.19 23.19

Saline 3,000 19/20 (95%) 34.11 29.42 20.86

ESwabTM 4,000 20/20 (100%) 34.03 30.65 23.70

CFX96 TouchTM

UTMD†/VTM 5,000 20/20 (100%) 37.22 31.24 27.07

Saline 3,000 19/20 (95%) 37.10 31.07 26.05

ESwabTM 6,000 20/20 (100%) 34.80 35.47 30.65

Inclusivity (in-silico)
The BioGX SARS-CoV-2 N1 primers and probes are identical in sequence to those reported in the
CDC 2019-Novel Coronavirus (2019-nCoV) Real-Time RT-PCR Diagnostic Panel. The CDC reported
an �Q�[�Ÿ�h�Q�Y�Q�E�] analysis of primer and probe sequences within their IFU (CDC-006-00019, Rev 05)3.
An alignment was performed with the oligonucleotide primer and probe sequences of the CDC
2019 nCoV Real-Time RT-PCR Diagnostic Panel with all publicly available nucleic acid sequences
for 2019-nCoV in GenBank as of June 20, 2020, to demonstrate the predicted inclusivity of the
CDC 2019 nCoV Real-Time RT-PCR Diagnostic panel. All the alignments show >99% identity of the
CDC panel to the available 2019-nCoV sequences with the exception of one sequence with a
mismatch frequency of >1% in the N1 probe, all other sequences assessed had mismatch
frequencies <1%. From the mismatch frequencies with <1%, two separate deposited sequences
were observed to have two mismatches in the N1 probe and N1 reverse primer.

SARS-CoV-2 variants [B.1.1.7 lineage and 501Y.V2 variants]: To confirm inclusivity of the
SARS-CoV-2 variants [e.g., B.1.1.7 lineage and 501Y.V2 variants (within B.1.351 lineage)]
circulating in the United Kingdom, South Africa, and other countries, BioGX utilized the GISAID
database to obtain genomic sequence data and perform �Q�[�Ÿ�h�Q�Y�Q�E�] analysis to determine if the
potentially more infectious B.1.1.7 lineage or 501Y.V2 variants also possessed mutations in the N
region targeted by the BioGX �8�N�g�I�ITM COVID-19 Direct RT-PCR test. BioGX �Q�[�Ÿ�h�Q�Y�Q�E�] analysis utilized
over 4,200 SARS-CoV-2 B.1.1.7 lineage genomes available from the GISAID and GenBank
databases (as of January 4, 2021). The predicted detection of 99.9% of the SARS-CoV-2 B.1.1.7
lineage remains unchanged with the BioGX �8�N�g�I�ITM COVID-19 Direct RT-PCR test. The �Q�[�Ÿ�h�Q�Y�Q�E�]
analysis demonstrated that the 320 genome sequences of the 501Y.V2 variant available in the
GISAID database (as of January 4, 2021) did not possess mutations in the N gene region that
would be predicted to affect PCR detection.

SARS-CoV-2 variant (S-gene L452R mutation): To confirm inclusivity of the SARS-CoV-2 variant
(S-gene L452R mutation) circulating in California, BioGX utilized the 793 SARS-CoV-2 genome
sequences possessing the S-gene mutation deposited within the GISAID database to performed
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�Q�[�Ÿ�h�Q�Y�Q�E�] analysis. As of January 18, 2021, the available SARS-CoV-2 variant (S-gene L452R
mutation) genomes demonstrated 98.9% to 100% homology to the N gene region targeted by
BioGX �8�N�g�I�ITM COVID-19 Direct RT-PCR test and are not expected to affect PCR detection.

SARS-CoV-2 P.1 variant (S-gene K417T, E484K, and N501Y mutations): To confirm inclusivity of
the SARS-CoV-2 P.1 variant (S-gene K417T, E484K, and N501Y mutations) circulating in Brazil,
BioGX utilized the 336 SARS-CoV-2 genome sequences possessing the S-gene mutations
deposited within the GISAID database to perform �Q�[�Ÿ�h�Q�Y�Q�E�] analysis. As of February 8, 2021, the
available SARS-CoV-2 P.1 variant genomes demonstrated 99.1% to 100% homology to the N gene
region targeted by BioGX �8�N�g�I�ITM COVID-19 Direct RT-PCR test and are expected to be detected
by the assay.

In summary, �Q�[�Ÿ�h�Q�Y�Q�E�] analysis of the currently circulating strains of the SARS-CoV-2 B.1.1.7
lineage, 501Y.V2 variant, L452R mutation and P.1 variant do not possess mutations within the the
targeted region of the N gene that are expected to affect detection of SARS-CoV-2 by the BioGX
�8�N�g�I�ITM COVID-19 Direct RT-PCR test.

Cross-Reactivity (Analytical Specificity)

Select high priority organisms represented in a respiratory specimen were evaluated using the
oligonucleotide primers and probes in BioGX �8�N�g�I�ITM COVID-19 by �Q�[�Ÿ�h�Q�Y�Q�E�] BLASTn alignments
with an expected threshold of 5000 for potential cross-reactivity (Table 6). The combination of
primers and probes did not produce significant sequence homology or identity which would
result in cross-reactivity reporting to any of the selected high priority respiratory specimens. The
primers and probes were further evaluated against high priority pathogens within the same
genetic family (e.g. human coronavirus strains, MERS-coronavirus). The resultant �Q�[�Ÿ�h�Q�Y�Q�E�] analysis
showed no significant homology to pathogens from the same genetic family (excluding
SARS-CoV-2).

Microbial Interference
None of the high priority microbial species above (also refer to Table 6), which could potentially
be present in the clinical specimens, showed any �Q�[�Ÿ�h�Q�Y�Q�E�] homology to the primers and probes
used in the assay, and the BioGX SARS-CoV-2 N1 primers and probes are identical in sequence to
those reported in the CDC 2019-Novel Coronavirus (2019-nCoV) Real-Time RT-PCR Diagnostic
Panel, therefore a microbial interference study specifically against these strains is not required
per FDA recommendations.3,14 Additionally, during the development and validation of the assay,
SARS-CoV-2 negative NP swabs obtained in kind, were collected from individuals presenting with
illness, de-identified of patient information, and tested with the BioGX �8�N�g�I�ITM COVID-19. These
patient samples resulted in 0% false positive detection. Additionally, in the event a sufficient
microbial contamination were to occur due to an improperly collected specimen, the IAC would
indicate if the excessive microbial load would inhibit RNA reverse transcription, amplification,
and detection.

Table 6. �8�N�g�I�ITM COVID-19 Direct RT-PCR primers and probes �Q�[�Ÿ�h�Q�Y�Q�E�] analysis of high priority organisms.
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Organism SARS-CoV-2 (N1)
Percent Identity

Organism SARS-CoV-2 (N1)
Percent Identity

Human coronavirus 229E 0% �
�P�Y�<�Z�s�G�Q�<���d�[�I�k�Z�]�[�Q�<�I 0%

Human coronavirus OC43 0% �� �<�I�Z�]�d�P�Q�Y�k�h���Q�[�N�Y�k�I�[�v�<�I 0%

Human coronavirus HKU1 0% � �I�O�Q�]�[�I�Y�Y�<���d�[�I�k�Z�]�d�P�Q�Y�< 0%

Human coronavirus NL63 0% �! �s�E�]�D�<�E�j�I�g�Q�k�Z���j�k�D�I�g�E�k�Y�]�h�Q�h 0%

MERS-coronavirus 0% �/�j�g�I�d�j�]�E�]�E�E�k�h���d�[�I�k�Z�]�[�Q�<�I 0%

SARS-coronavirus 0% �/�j�g�I�d�j�]�E�]�E�E�k�h���d�s�]�O�I�[�I�h 0%

Adenovirus 0% ���]�g�G�I�j�I�Y�Y�<���d�I�g�j�k�h�h�Q�h 0%

Human Metapneumovirus (hMPV) 0% �! �s�E�]�d�Y�<�h�Z�<���d�[�I�k�Z�]�[�Q�<�I 0%

Parainfluenza virus 1-4 0% �+�[�I�k�Z�]�E�s�h�j�Q�h���W�Q�g�]�p�I�E�Q�Q (PJP) 0%

Influenza A & B 0% �
�<�[�G�Q�G�<���<�Y�D�Q�E�<�[�h 0%

Enterovirus (e.g. EV68) 0% �+�h�I�k�G�]�Z�]�[�<�h���<�I�g�k�O�Q�[�]�h�< 0%

Respiratory syncytial virus 0% �/�j�<�d�P�s�Y�]�E�]�E�E�k�h���I�d�Q�G�I�g�Z�Q�G�Q�h 0%

Rhinovirus 0% �/�j�g�I�d�j�]�E�]�E�E�k�h���h�<�Y�Q�p�<�g�Q�k�h 0%

Interfering Substances
Potential interfering substances were spiked into pooled Copan UTMD† negative nasopharyngeal
swab samples containing SARS-CoV-2 (USA-WA1/2020; Zeptometrix catalog number
NATSARS(CoV2)-ST) at 5X LoD (5,000 copies/mL). Table 7 summarizes the replicate runs (n=3)
conducted for each substance with the indicated concentrations. All runs were conducted with
direct sample addition to the master mix and analyzed with the both the Applied Biosystems
QuantStudioTM 5 and Bio-Rad CFX96 TouchTM.

The BioGX �8�N�g�I�ITM COVID-19 assay utilizes a single stranded RNA Internal Amplification Control
(IAC) included in every reaction. The single stranded RNA IAC shows conditions for amplification
within the reaction were suitable for reverse transcription, PCR amplification, and generation of
fluorescence to take place. In the event a Direct tested sample contains interfering substances
which are detrimental to the real time PCR, by either inhibiting reverse transcription or cDNA
polymerization, the IAC would fail to
amplify and report. The results interpretation of such a sample as an indeterminate, requires the
analyst to first retest the sample, and if it is still inhibitory to collect another sample for testing. A
similar strategy is employed for extracted samples. As such, false negative results due to
inhibition are mitigated by the incorporation of the single stranded RNA IAC into each test to
identify inhibition, and providing a reflexive testing strategy that indicates need for new sample
collection or re-testing with established extraction procedure.

�3�D�J�H���� �R�I���� �����������������; �0�3�����&�(�����5�H�Y�������������$�3�5��������



XfreeTM COVID-19 Direct RT-PCR
Extraction-Free - Multi-Platform

Table 7. Analysis of interfering substances.

Potential Interfering substance
Final concentration

(in sample)

Agreement with expected results

QuantStudioTM 5 CFX96 TouchTM

Positive

NP

Negative

NP

Positive

NP

Negative

NP

None N/A 100% 100% 100% 100%

Mucin (bovine submaxillary gland, type
I-S)

2.5 mg/mL 100% 100% 100% 100%

Mucin (bovine submaxillary gland, type
I-S)

1.25 mg/mL 100% 100% 100% 100%

Nasacort 10% v/v 100% 100% 100% 100%

NeilMed NasoGEL 1.25% w/v 100% 100% 100% 100%

Similasan Nasal Allergy ReliefTM 15% v/v 100% 100% 100% 100%

Saline Nasal Spray 15% v/v 100% 100% 100% 100%

Act dry mouth lozenges 0.04 g/mL 100% 100% 100% 100%

Chloraseptic® Spray 10% v/v 100% 100% 100% 100%

Cepacol Extra Strength Cherry
Lozenges

0.046 g/mL
(0.15mg/mL Benzocaine)

100% 100% 100% 100%

Chloraseptic Lozenges
0.071 g/mL

(0.12mg/mL Benzocaine)
100% 100% 100% 100%

Halls Cough drops
0.062 g/mL

(0.15 mg/mL Menthol)
100% 100% 100% 100%

Nature’s Bounty® Zinc (50mg) 10µg/mL 100% 100% 100% 100%
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Table 7 (continued). Analysis of interfering substances.

Potential Interfering substance
Final concentration

(in sample)

Agreement with expected results

QuantStudioTM 5 CFX96 TouchTM

Positive

NP

Negative

NP

Positive

NP

Negative

NP

Nyquil 10% v/v 100% 100% 100% 100%

Robitussin 10% v/v 100% 100% 100% 100%

Flonase 5% v/v 100% 100% 100% 100%

Ethanol 5% v/v 100% 100% 100% 100%

ORIGINAL LISTERINE® Mouthwash 5% v/v 100% 100% 100% 100%

Colgate Toothpaste Original 1% v/v 100% 100% 100% 100%

Mupirocin Ointment (Bactroban) 5 mg/mL 100% 100% 100% 100%

Tobramycin (Antibiotic) 100 ng/mL 100% 100% 100% 100%

Oseltamivir (Tamiflu API) 3.3 mg/mL 100% 100% 100% 100%

Emergen-C Vitamin C Drink - Super
Orange

10% v/v 100% 100% 100% 100%

Petroleum jelly (Vaseline) 1% w/v 100% 100% 100% 100%

Tobacco 1% v/v 100% 100% 100% 100%

Tobacco 0.5% v/v 100% 100% 100% 100%
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Table 7 (continued). Analysis of interfering substances.

Potential Interfering substance
Final concentration

(in sample)

Agreement with expected results

QuantStudioTM 5 CFX96 TouchTM

Positive

NP

Negative

NP

Positive

NP

Negative

NP

Human DNA 10 ng/µL 100% 100% 100% 100%

White blood cells
10% v/v

(4.5x105-1.10x106/mL)
100% 100% 100% 100%

Whole Blood 2.5% v/v 100% 100% 100% 100%

Whole Blood 1.0% v/v 100% 100% 100% 100%

Clinical Performance

Clinical performance of the BioGX �8�N�g�I�ITM COVID-19 assay was evaluated using clinical samples
previously identified and confirmed with the FDA-EUA comparator methods: LineaTM COVID-19
Assay Kit. Positive Percent Agreement (PPA) and Negative Percent Agreement (NPA) was
determined using 66 individual positive and 35 individual negative clinical samples, collected by
qualified healthcare professionals. Samples were handled as described in the package insert of
the collection device and stored frozen until use.

Testing with Direct Patient Sample Addition
The clinical samples were tested by Direct sample addition (5 µL of clinical sample transferred
directly into 15 µL of the BioGX �8�N�g�I�ITM COVID-19 mastermix). Clinical sample analysis on the
QuantStudioTM 5 from high, medium, and low positive clinical patient samples (n=66) and
negative clinical patient samples (n=35), Direct sample addition achieved a 95.45% PPA and
100% NPA when compared to the comparator method (Table 8).

Testing with Extracted Patient Samples
The clinical samples were extracted with Qiagen Viral RNA Mini Kit following the manufacturer’s
recommendations where 140 µL of clinical sample is extracted and then eluted with 50 µL
RNase-free water. The eluted nucleic acid template (5 µL) is added to 10 µL of the BioGX �8�N�g�I�ITM

master mix. Extracted high, medium, and low positive clinical patient samples (n=66) and
negative clinical patient samples (n=35) yielded PPA and NPA of 100% and 94.29%, respectively,
when analyzed on the QuantStudioTM 5 (Table 9).

Table 8. Clinical performance percent agreement of Direct sample addition with QuantStudioTM 5
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and comparator method (LineaTM COVID-19 assay).

QuantStudioTM 5 Direct
Sample Addition

Comparator Method:
LineaTM COVID-19 assay

�8�N�g�I�ITM COVID-19 Direct RT-PCR �+�]�h�Q�j�Q�p�I �"�I�O�<�j�Q�p�I

�+�]�h�Q�j�Q�p�I 63 0

�"�I�O�<�j�Q�p�I 3* 35

�+�]�h�Q�j�Q�p�I���+�I�g�E�I�[�j���� �O�g�I�I�Z�I�[�j���¥�È�Ä�Ø�
���¦ 95.45% (87.29-99.05%)

�"�I�O�<�j�Q�p�I���+�I�g�E�I�[�j���� �O�g�I�I�Z�I�[�j���¥�È�Ä�Ø�
���¦ 100% (90.00-100%)

*The three direct samples with discordant results were identified as positive by the comparator method with Ct values between
37.6 & 40.5. Ct values in these ranges, will inherently be subject to sampling bias where inconsistent results will occur due to the
variability in sampling low copy numbers.

Table 9. Clinical performance percent agreement of Extracted sample addition wit

QuantStudioTM 5 and comparator method (LineaTM COVID-19 assay).

QuantStudioTM 5
Qiagen Extracted Nucleic Acid

Comparator Method:
LineaTM COVID-19 assay

�8�N�g�I�ITM COVID-19 Direct RT-PCR �+�]�h�Q�j�Q�p�I �"�I�O�<�j�Q�p�I

�+�]�h�Q�j�Q�p�I 66 2*

�"�I�O�<�j�Q�p�I 0 33

�+�]�h�Q�j�Q�p�I���+�I�g�E�I�[�j���� �O�g�I�I�Z�I�[�j 100% (94.56-100%)

�"�I�O�<�j�Q�p�I���+�I�g�E�I�[�j���� �O�g�I�I�Z�I�[�j 94.29% (80.84-99.3%)

*�8�N�g�I�I COVID-19 positive reporting of the two samples (reported negative by Linea COVID-19 assay) was confirmed by the
samples provider as positives when tested with another EUA approved method.
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APPENDIX A

Applied Biosystems QuantStudioTM 5 - Thermocycling Programing

Direct Patient Sample (20 μL reaction volume)

Please refer to the following steps for QuantStudioTM 5 manual programming specific for Direct
Patient sample testing.

1. Open the QuantStudio Design and Analysis Software v1.5.1
2. Select the “Create New Experiment” option
3. Within the properties tab, select the following properties to filter:

a. Name: User defined or 500003XMPDirectQS5v2
b. Instrument Type: QuantStudio 5 System
c. Block Type: 96-Well 0.2 mL
d. Experiment type: Standard Curve
e. Chemistry: TaqMan Reagents
f. Run mode: Standard

4. Run Method (Method Tab)
a. Change the Reaction Volume to 20.0 μL
b. Temperature of the enabled heated cover will remain at 105.0 °C
c. Within the “PCR Stage “ section of the thermocycling parameters, an additional

step will need to be added by bringing the mouse pointer above “Step 2” will
allow the “+” and “-” buttons to become visible.

d. Click the “+” button to add “Step 3” to the “PCR Stage”.
e. Going back to the first hold stage enter the following parameters (Table A1):

i. Hold Stage: Step 1
1. 1.6 ramp rate
2. 46°C
3. 20 minutes

ii. Hold Stage: Step 2
1. 1.6 ramp rate
2. 95°C
3. 5 minutes

iii. PCR Stage: Step 1
1. 1.6 ramp rate
2. 95°C
3. 3 seconds
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iv. PCR Stage: Step 2
1. 1.6 ramp rate
2. 62°C
3. 20 seconds
4. Scanning is turned ON by clicking the camera icon (dark blue when ON).

v. PCR Stage: Step 3
1. 1.6 ramp rate
2. 70°C
3. 5 seconds
4. Scanning is turned OFF by clicking the camera icon (light
blue when OFF).

vi. Number of cycles set to 40 (located at the bottom of the “PCR Stage” section).

Table A1. QuantStudioTM 5 thermocycling summary - Direct Patient Sample.

PCR Cycle Summary

Hold Stage PCR Stage

Conditions Step 1 Step 2 Step 1 Step 2 Step 3

Ramp Rate (°C/s) 1.6 1.6 1.6 1.6 1.6

Temperature (°C/s) 46 95 95 62 70

Duration (Min:sec) 20:00 5:00 0:03 0:20 0:05

Detection OFF OFF OFF ON OFF

No. of PCR Cycles HOLD HOLD 40

5. Plate Setup (Plate Tab)
a. Under the “Plate Attribute” section of the Quick Setup tab, change the Passive

Reference to “NONE”.
b. On the left side of the screen (next to Quick Setup), choose “Advanced Setup”.
c. In the “Targets” section, click on the “Add” box and add two targets for a total of

three. Rename Target1 as “RNaseP”.
d. Click the associated reporter box below the Reporter tab and, from the drop down

menu, choose “FAM”.
e. Click on the “Target 2” box and change the name to “N1”.
f. Click the associated reporter box below the Reporter tab and, from the drop down

menu, choose “ROX”.
g. Click on the “Target 3” box and change the name to “IAC”.
h. Click the associated reporter box below the Reporter tab and, from the drop down

menu, choose “Cy5”
i. Ensure that the “Quencher” tab for all three targets is set to “None”.
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j. Highlight all the wells that you intend to use and ensure that the boxes besides
the three targets are selected and in the task select “U” for unknown. This should
populate the plate on the right side of the screen with each target.

k. To name your wells by sample name, select the appropriate well on the right side
of the screen. Under the “Samples” tab on the left side, click on the current
sample name and rename to whatever is desired for the experiment. Check the
box besides the sample name: the names will populate on the right side.

l. To add additional sample names, click “Add” on the samples tab and repeat the
instructions above.

m. Click on the “Results” tab on the top of the screen
6. Threshold Setup (Results Tab)

a. Navigate to the “Results” tab and select the settings wheel besides “Analyze” in
the upper right corner.

b. Click on target “N1” and uncheck the “Ct Settings to Use: Default Settings” box
directly to the right. Then uncheck the “Automatic Threshold” box: set the
threshold to 10,000.

c. Click on target “RNaseP” and uncheck the “Ct Settings to Use: Default Settings”
box directly to the right. Then uncheck the “Automatic Threshold” box: set the
threshold to 25,000.

d. Click on target “IAC” and uncheck the “Ct Settings to Use: Default Settings” box
directly to the right. Then uncheck the “Automatic Threshold” box: set the
threshold to 5,000.

e. Click “Apply” in the bottom right corner.
7. Save File

a. Navigate to the “File” tab and choose “Save As”. Name the file
‘500003XMPDirectQS5v2’ and ensure it is saved as an *.edt file.

8. Run File
a. Select “File” then ”Open”.
b. Select your chosen *.edt file.
c. Navigate to the “Run” tab, and click the dropdown arrow next to

“Start Run”. Ensure the name of the instrument is your preferred instrument. You
will be prompted to enter a name for the run.

d. Insert the desired run name and click “Start Run”.
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Applied Biosystems QuantStudioTM 5 - Thermocycling Programing

Extracted Patient Sample (15 μL reaction volume)

Please refer to the following steps for QuantStudioTM 5 manual programming specific for
Extracted Patient sample testing.

1. Open the QuantStudio Design and Analysis Software v1.5.1

2. Select the “Create New Experiment” option

3. Within the properties tab, select the following properties to filter:
a. Name: User defined or 500003XMPExtractQS5v2
b. Instrument Type: QuantStudio 5 System
c. Block Type: 96-Well 0.2 mL
d. Experiment type: Standard Curve
e. Chemistry: TaqMan Reagents
f. Run mode: Standard

4. Run Method (Method Tab)
a. Change the Reaction Volume to 15.0 μL
b. Temperature of the enabled heated cover will remain at 105.0 °C
c. Within the “PCR Stage “ section of the thermocycling parameters, an additional

step will need to be added by bringing the mouse pointer above “Step 2” will
allow the “+” and “-” buttons to become visible.

d. Click the “+” button to add “Step 3” to the “PCR Stage”.
e. Going back to the first hold stage enter the following parameters (Table A1):

i. Hold Stage: Step 1
1. 1.6 ramp rate
2. 46°C
3. 20 minutes

ii. Hold Stage: Step 2
1. 1.6 ramp rate
2. 95°C
3. 5 minutes

iii. PCR Stage: Step 1
1. 1.6 ramp rate
2. 95°C
3. 3 seconds

�3�D�J�H���� �R�I���� �����������������; �0�3�����&�(�����5�H�Y�������������$�3�5��������



XfreeTM COVID-19 Direct RT-PCR
Extraction-Free - Multi-Platform

iv. PCR Stage: Step 2
1. 1.6 ramp rate
2. 62°C
3. 20 seconds
4. Scanning is turned ON by clicking the camera icon (dark blue when ON).

v. PCR Stage: Step 3
1. 1.6 ramp rate
2. 70°C
3. 5 seconds
4. Scanning is turned OFF by clicking the camera icon (light
blue when OFF).

vi. Ensure the number of cycles is set to 40 (located at the bottom
border of the PCR Stage).

5. Plate Setup (Plate Tab)
a. Under the “Plate Attribute” section of the Quick Setup tab, change the Passive

Reference to “NONE”.
b. On the left side of the screen (next to Quick Setup), choose “Advanced Setup”.
c. In the “Targets” section, click on the “Add” box and add two targets for a total of

three. Rename Target1 as “RNaseP”.
d. Click the associated reporter box below the Reporter tab and, from the drop down

menu, choose “FAM”.
e. Click on the “Target 2” box and change the name to “N1”.
f. Click the associated reporter box below the Reporter tab and, from the drop down

menu, choose “ROX”.
g. Click on the “Target 3” box and change the name to “IAC”.
h. Click the associated reporter box below the Reporter tab and, from the drop down

menu, choose “Cy5”
i. Ensure that the “Quencher” tab for all three targets is set to “None”.
j. Highlight all the wells that you intend to use and ensure that the boxes besides

the three targets are selected. In the “Task” section select “U” for unknown. This
should populate the plate on the right side of the screen with each target.

k. To name your wells by sample name, select the appropriate well on the right side
of the screen. Under the “Samples” tab on the left side, click on the current
sample name and rename to whatever is desired for the experiment. Check the
box besides the sample name: the names will populate on the right side.

l. To add additional sample names, click “Add” on the samples tab and repeat the
instructions above.

m. Click on the “Results” tab on the top of the screen

6. Threshold Setup (Results Tab)
a. Navigate to the “Results” tab and select the settings wheel besides “Analyze” in

the upper right corner.
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b. Click on target “N1” and uncheck the “Ct Settings to Use: Default Settings” box
directly to the right. Then uncheck the “Automatic Threshold” box: set the
threshold to 10,000.

c. Click on target “RNaseP” and uncheck the “Ct Settings to Use: Default Settings”
box directly to the right. Then uncheck the “Automatic Threshold” box: set the
threshold to 25,000.

d. Click on target “IAC” and uncheck the “Ct Settings to Use: Default Settings” box
directly to the right. Then uncheck the “Automatic Threshold” box: set the
threshold to 5,000.

e. Click “Apply” in the bottom right corner.

7. Save File
a. Navigate to the “File” tab and choose “Save As”. Name the file

‘500003XMPExtractQS5v2’ and ensure it is saved as an *.edt file.
8. Run File

a. Select “File” then ”Open”.
b. Select your chosen *.edt file.
c. Navigate to the “Run” tab, and click the dropdown arrow next to

“Start Run”. Ensure the name of the instrument is your preferred instrument. You
will be prompted to enter a name for the run.

d. Insert the desired run name and click “Start Run”.
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Applied Biosystems QuantStudioTM 5 - Thermocycling Programing

Pooling - Direct Pooled Patient Sample (40 μL reaction volume)

Please refer to the following steps for QuantStudioTM 5 manual programming specific for Direct
Patient sample testing.

1. Open the QuantStudio Design and Analysis Software v1.5.1
2. Select the “Create New Experiment” option
3. Within the properties tab, select the following properties to filter:

a. Name: User defined or 500003XMPDirectPooledQS5Rev01.edt
b. Instrument Type: QuantStudio 5 System
c. Block Type: 96-Well 0.2 mL
d. Experiment type: Standard Curve
e. Chemistry: TaqMan Reagents
f. Run mode: Standard

4. Run Method (Method Tab)
a. Change the Reaction Volume to 40.0 μL
b. Temperature of the enabled heated cover will remain at 105.0 °C
c. Within the “PCR Stage “ section of the thermocycling parameters, an additional

step will need to be added by bringing the mouse pointer above “Step 2” will
allow the “+” and “-” buttons to become visible.

d. Click the “+” button to add “Step 3” to the “PCR Stage”.
e. Going back to the first hold stage enter the following parameters (Table A1):

i. Hold Stage: Step 1
1. 1.6 ramp rate
2. 46°C
3. 20 minutes

ii. Hold Stage: Step 2
1. 1.6 ramp rate
2. 95°C
3. 5 minutes

iii. PCR Stage: Step 1
1. 1.6 ramp rate
2. 95°C
3. 3 seconds

iv. PCR Stage: Step 2
1. 1.6 ramp rate
2. 62°C
3. 20 seconds
4. Scanning is turned ON by clicking the camera icon (dark blue when ON).

v. PCR Stage: Step 3
1. 1.6 ramp rate
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2. 70°C
3. 5 seconds
4. Scanning is turned OFF by clicking the camera icon (light
blue when OFF).

vi. Number of cycles set to 40 (located at the bottom of the “PCR Stage” section).

5. Plate Setup (Plate Tab)
a. Under the “Plate Attribute” section of the Quick Setup tab, change the Passive

Reference to “NONE”.
b. On the left side of the screen (next to Quick Setup), choose “Advanced Setup”.
c. In the “Targets” section, click on the “Add” box and add two targets for a total of

three. Rename Target1 as “RNaseP”.
d. Click the associated reporter box below the Reporter tab and, from the drop down

menu, choose “FAM”.
e. Click on the “Target 2” box and change the name to “N1”.
f. Click the associated reporter box below the Reporter tab and, from the drop down

menu, choose “ROX”.
g. Click on the “Target 3” box and change the name to “IAC”.
h. Click the associated reporter box below the Reporter tab and, from the drop down

menu, choose “Cy5”
i. Ensure that the “Quencher” tab for all three targets is set to “None”.
j. Highlight all the wells that you intend to use and ensure that the boxes besides

the three targets are selected and in the task select “U” for unknown. This should
populate the plate on the right side of the screen with each target.

k. To name your wells by sample name, select the appropriate well on the right side
of the screen. Under the “Samples” tab on the left side, click on the current
sample name and rename to whatever is desired for the experiment. Check the
box besides the sample name: the names will populate on the right side.

l. To add additional sample names, click “Add” on the samples tab and repeat the
instructions above.

m. Click on the “Results” tab on the top of the screen
6. Threshold Setup (Results Tab)

a. Navigate to the “Results” tab and select the settings wheel besides “Analyze” in
the upper right corner.

b. Click on target “N1” and uncheck the “Ct Settings to Use: Default Settings” box
directly to the right. Then uncheck the “Automatic Threshold” box: set the
threshold to 10,000.

c. Click on target “RNaseP” and uncheck the “Ct Settings to Use: Default Settings”
box directly to the right. Then uncheck the “Automatic Threshold” box: set the
threshold to 25,000.

d. Click on target “IAC” and uncheck the “Ct Settings to Use: Default Settings” box
directly to the right. Then uncheck the “Automatic Threshold” box: set the
threshold to 5,000.

e. Click “Apply” in the bottom right corner.
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7. Save File
a. Navigate to the “File” tab and choose “Save As”. Name the file

‘500003XMPDirectPooledQS5Rev01’ and ensure it is saved as an *.edt file.
8. Run File

a. Select “File” then ”Open”.
b. Select your chosen *.edt file.
c. Navigate to the “Run” tab, and click the dropdown arrow next to

“Start Run”. Ensure the name of the instrument is your preferred instrument. You
will be prompted to enter a name for the run.

d. Insert the desired run name and click “Start Run”.
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APPENDIX B

Applied Biosystems 7500 Fast Dx - Thermocycling Programing

Direct Patient Sample (20 μL reaction volume)

Please refer to the following steps for Applied Biosystems 7500 Fast Dx manual programming
specific for Direct Patient sample testing.

1. Open the Applied Biosystems 7500 Fast Dx software v1.4.1
2. Go to the “Tools” tab and navigate to “Detector Manager”

a. Click on the “File” dropdown and select “New”.
b. Name the target as “N1”

i. Set the reporter dye to “ROX”
ii. Set the quencher dye to none

iii. Click Apply
c. Name the target as “RNaseP”

i. Set the reporter dye to “FAM”
ii. Set the quencher dye to “None”

iii. Click Apply
d. Name the target as “IAC”

i. Set the reporter dye to “Cy5”
ii. Set the quencher dye to “None”

iii. Click Apply
3. Click the “File” tab and select “New”
4. On the “Define document” Pop-Up:

a. Assay: Standard Curve (Absolute Quantification)
b. Container: 96 Well Clear
c. Template: Blank Document
d. Run Mode: Fast 7500
e. Operator: Select the operator you wish to run the assay with
f. Plate Name: Select your desired name for the experiment file
g. Click “Next”

5. Select the previously created detectors from the library: N1, RNaseP, IAC and click add.
6. Set the Passive Reference to “None”
7. Click “next”. Select all the wells and assign the targets to them.
8. Select Finish.
9. Navigate to the Instrument tab.

a. Change the Sample Volume to 20.0 μL
b. Click the “Add Hold” button until you have two hold steps. Set the number of

repetitions to 1.
c. Click the “Add Step” button until you have three PCR cycling steps. Set the number

of repetitions for this stage to 40.
d. Going back to the first hold stage enter, the following parameters (Table B1):
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i. Hold Stage: Step 1
1. Auto ramp rate
2. 46°C
3. 20 minutes

ii. Hold Stage: Step 2
1. Auto ramp rate
2. 95°C
3. 5 minutes

iii. PCR Stage: Step 1
1. Auto ramp rate
2. 95°C
3. 3 seconds

iv. PCR Stage: Step 2
1. Auto ramp rate
2. 62°C
3. 24 seconds.

v. PCR Stage: Step 3
1. Auto ramp rate
2. 70°C
3. 5 seconds

vi. Under settings, select the following:
1. Sample Volume: 20
2. Run Mode: Fast 7500
3. Data Calculation: Stage 3, step 2

e. Select the “Analysis” tab and click “Analysis settings”.
i. Select N1’s target settings by clicking on the detector dropdown.

1. Select “Manual CT” and set the threshold to 50,000
2. Select “Manual Baseline” and set the start cycle to 3 and the end to

10.
3. Click apply

ii. Select RNaseP
1. Select Manual CT and set the threshold to 100,000
2. Select “Manual Baseline” and set the start cycle to 3 and the end to

15
3. Click apply

iii. Select IAC
1. Select Manual CT and set the threshold to 100,000
2. Select “Manual Baseline” and set the start cycle to 3 and the end to

20
3. Click “Apply”, then select “OK”.

f. Select File -> Save. Set your desired name and your template is saved.

Table B1. Applied Biosystems 7500 thermocycling summary - Direct Patient Sample.
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PCR Cycle Summary

Hold Stage PCR Stage

Conditions Step 1 Step 2 Step 1 Step 2 Step 3

Ramp Rate (°C/s) Auto Auto Auto Auto Auto

Temperature (°C/s) 46 95 95 62 70

Duration (Min:sec) 20:00 5:00 0:03 0:24 0:05

Detection OFF OFF OFF ON OFF

No. of PCR Cycles HOLD HOLD 40
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Applied Biosystems 7500 Fast Dx- Thermocycling Programing

Extracted Patient Sample (15 μL reaction volume)

Please refer to the following steps for Applied Biosystems 7500 Fast Dx manual programming
specific for Extracted patient sample testing.

1. Open the Applied Biosystems 7500 Fast Dx software v1.4.1
2. Go to the “Tools” tab and navigate to “Detector Manager”

a. Click on the “File” dropdown and select “New”.
b. Name the target as “N1”

i. Set the reporter dye to “ROX”
ii. Set the quencher dye to none

iii. Click Apply
c. Name the target as “RNaseP”

i. Set the reporter dye to “FAM”
ii. Set the quencher dye to “None”

iii. Click Apply
d. Name the target as “IAC”

i. Set the reporter dye to “Cy5”
ii. Set the quencher dye to “None”

iii. Click Apply
3. Click the “File” tab and select “New”
4. On the “Define document” Pop-Up:

a. Assay: Standard Curve (Absolute Quantification)
b. Container: 96 Well Clear
c. Template: Blank Document
d. Run Mode: Fast 7500
e. Operator: Select the operator you wish to run the assay with
f. Plate Name: Select your desired name for the experiment file
g. Click “Next”

5. Select the previously created detectors from the library: N1, RNaseP, IAC and click add.
6. Set the Passive Reference to “None”
7. Click “next”. Select all the wells and assign the targets to them.
8. Select Finish.
9. Navigate to the Instrument tab.

a. Change the Sample Volume to 15.0 μL
b. Click the “Add Hold” button until you have two hold steps. Set the number of

repetitions to 1.
c. Click the “Add Step” button until you have three PCR cycling steps. Set the number

of repetitions for this stage to 40.
d. Going back to the first hold stage enter, the following parameters (Table B1):

i. Hold Stage: Step 1
1. Auto ramp rate
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2. 46°C
3. 20 minutes

ii. Hold Stage: Step 2
1. Auto ramp rate
2. 95°C
3. 5 minutes

iii. PCR Stage: Step 1
1. Auto ramp rate
2. 95°C
3. 3 seconds

iv. PCR Stage: Step 2
1. Auto ramp rate
2. 62°C
3. 24 seconds.

v. PCR Stage: Step 3
1. Auto ramp rate
2. 70°C
3. 5 seconds

vi. Under settings, select the following:
1. Sample Volume: 20
2. Run Mode: Fast 7500
3. Data Calculation: Stage 3, step 2

e. Select the “Analysis” tab and click “Analysis settings”.
i. Select N1’s target settings by clicking on the detector dropdown.

1. Select “Manual CT” and set the threshold to 50,000
2. Select “Manual Baseline” and set the start cycle to 3 and the end to

10.
3. Click apply

ii. Select RNaseP
1. Select Manual CT and set the threshold to 100,000
2. Select “Manual Baseline” and set the start cycle to 3 and the end to

15
3. Click apply

iii. Select IAC
1. Select Manual CT and set the threshold to 100,000
2. Select “Manual Baseline” and set the start cycle to 3 and the end to

20
3. Click “Apply”, then select “OK”.

f. Select File -> Save. Set your desired name and your template is saved.

�3�D�J�H���� �R�I���� �����������������; �0�3�����&�(�����5�H�Y�������������$�3�5��������



XfreeTM COVID-19 Direct RT-PCR
Extraction-Free - Multi-Platform

APPENDIX C

Bio-Rad CFX96 TouchTM - Thermocycling Programing

Direct Patient Sample (20 μL reaction volume)

Please refer to the following steps for CFX96 TouchTMmanual programming specific for Direct
Patient sample testing.

1. Launch the CFX Maestro software.

2. Select “File”, then choose “New” and select “Protocol”

3. Program thermocycling conditions in the Protocol Editor
a. Set Sample Volume to 20 μL
b. Click “Insert Step” to add a total of five total steps and program as follows (Table C1):
c. Step 1

i. Temp: 46°C
ii. Time: 20:00

d. Step 2
i. Temp: 95°C
ii. Time: 5:00

e. Step 3
i. Temp: 95°C
ii. Time: 0:03

f. Step 4
i. Temp: 62°C
ii. Time: 0:20
iii. Click “Add Plate Read to Step”. Also, ensure this is the only step containing a
plate read

g. Step 5
i. Temp: 70°C
ii. Time: 0:05

h. Step 6
i. Click to highlight “GOTO” and enter “3” to indicate thermocycling
includes Step 3, Step 4 and Step 5.
ii. At “GOTO 3”, confirm “39 more times” is programmed for a total of 40 cycles.

I. Save the new cycling conditions as protocol for future use
i. At the upper left of the screen select the Save button
ii. Save in the ExpressLoad folder
iii. Name the file ‘500003XMPDirectCFX96v2’
iv. Save as type ‘Protocol File (*.prcl)’
v. Select Save
vi. Click Ok in the protocol editor window
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Table C1. CFX96 TouchTM thermocycling summary - Direct Patient Sample.

PCR Cycle Summary

Hold Stage PCR Stage

Conditions Step 1 Step 2 Step 1 Step 2 Step 3

Temperature (°C/s) 46 95 95 62 70

Duration (Min:sec) 20:00 5:00 0:03 0:20 0:05

Detection OFF OFF OFF ON OFF

No. of PCR Cycles HOLD HOLD 40

4. Define the plate setup
a. Select “File” then choose “New” and select “Plate”
b. In the Plate Editor, click settings and ensure your settings are as follows

i. Plate Size: 96 wells
ii. Plate Type: BR White OR BR Clear (BioGX recommends BR White)

c. Highlight all wells and choose “Select Fluorophores”
i. Uncheck all currently selected wells and check ONLY the following: FAM, Cal Red
610, Quasar 670

d. For “Sample Type” select “Unknown”
e. Check the boxes besides all three of your selected fluorophores. Change the

target name as follows:
i. FAM: RNaseP
ii. Cal Red 610: N1
iii. Quasar 670: IAC

f. Save the new plate setup for future use
i. At the upper left of the screen select ”File” then select “Save”
iii. Name the file ‘500003XMPDirect_plateCFX96v2’
iv. Save as type ‘Plate File (*.pltd)’
v. Select Save
vi. Click Ok in the Plate Editor window

g. Saving Protocol
i. Select “File” then “Open”
ii. Select “Protocol” then open your saved protocol.
ii. Ensure the PCR steps are correct and click “OK”
iii. Click the “Plate” tab and choose “Select Existing”. Choose the
plate that was saved.
iv. Add any desired notes and click on the “Start Run” tab.
v. Save the run with the desired name

h. Assigning a sample name to well positions
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Once the run has begun, reaction wells can be assigned with a unique sample

name as follows:

i. Navigate to “Real Time Status”

ii. On the top-middle section of the screen, click “Plate Set-Up”

followed by “View/Edit Plate”.

iii.Click “Spreadsheet View/Importer” on the upper right quadrant of

the screen. Wells can be named with unique identifiers for

Sample Name, Sample Type, etc.

5. When CFX96 TouchTM run is completed, threshold setting update will need to be completed
as follows:

a. Open the “Data Analysis” window for your specific run
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel and

Quasar 670-channel and be sure “FAM” is checked (Note: Threshold adjustments
can be performed only in single threshold mode, be sure only one dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select “User

Defined” and enter “500”
iii.Click “OK” and the threshold for FAM will apply to the experiment.

c. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel and
Quasar 670-channel and be sure “CalRed 610” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure only one
dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select “User

Defined” and enter “500”
iii.Click “OK” and the threshold for CalRed 610 will apply to the experiment

d. To apply threshold settings for Quasar 670-channel, uncheck FAM-channel and
CalRed 610-channel and be sure “Quasar 670” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure only one
dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select “User

Defined” and enter “500”
iii.Click “OK” and the threshold for Quasar 670 will apply to the experiment

6. Refer to Table 2 for result interpretation.
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Bio-Rad CFX96 TouchTM - Thermocycling Programing

Extracted Patient Sample (15 μL reaction volume)

Please refer to the following steps for CFX96 TouchTM manual programming specific for Extracted
Patient sample testing.

1. Launch the CFX Maestro software.

2. Choose “File”, then choose “New” and select “Protocol”

3. Program thermocycling conditions in the Protocol Editor
a. Set Sample Volume to 15 μL
b. Click “Insert Step” to add a total of five total steps and program as follows (Table C1):
c. Step 1

i. Temp: 46°C
ii. Time: 20:00

d. Step 2
i. Temp: 95°C
ii. Time: 5:00

e. Step 3
i. Temp: 95°C
ii. Time: 0:03

f. Step 4
i. Temp: 62°C
ii. Time: 0:20
iii. Click “Add Plate Read to Step”. Also, ensure this is the only step containing a
plate read

g. Step 5
i. Temp: 70°C
ii. Time: 0:05

h. Step 6
i. Click to highlight “GOTO” and enter “3” to indicate thermocycling
includes Step 3, Step 4 and Step 5.
ii. At “GOTO 3”, confirm “39 more times” is programmed for a total of 40 cycles.

i. Save the new cycling conditions as a protocol for future use
i. At the upper left of the screen select the Save button
ii. Save in the ExpressLoad folder
iii. Name the file ‘500003XMPExtractCFX96v2’
iv. Save as type ‘Protocol File (*.prcl)’
v. Select Save
vi. Click Ok in the protocol editor window

4. Define the plate setup
a. Select “File” then choose “New” and select “Plate”
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b. In the Plate Editor, click settings and ensure your settings are as follows
i. Plate Size: 96 wells
ii. Plate Type: BR White OR BR Clear (BioGX recommends BR White)

c. Highlight all wells and choose “Select Fluorophores”
i. Uncheck all currently selected wells and check ONLY the following: FAM, Cal Red
610, Quasar 670

d. For “Sample Type” select “Unknown”
e. Check the boxes besides all three of your selected fluorophores. Change the

target name as follows:
i. FAM: RNaseP
ii. CalRed 610: N1
iii.: Quasar 670: IAC

f. Save the new plate setup for future use
i. At the upper left of the screen select ”File” then select “Save”
iii. Name the file “500003XMPExtract_plateCFX96v2”.
iv. Ensure it is saved in the “*.pltd” format
v. Select Save
vi. Click Ok in the Plate Editor window

g. Saving Protocol
i. Select “File” then “Open”
ii. Select “Protocol” then open your saved protocol.
ii. Ensure the PCR steps are correct and click “OK”
iii. Click the “Plate” tab and choose “Select Existing”. Choose the
plate that was saved.
iv. Add any desired notes and click on the “Start Run” tab.
v. Save the run with the desired name

h. Assigning a sample name to well positions
Once the run has begun, reaction wells can be assigned with a unique sample

name as follows:

i. Navigate to “Real Time Status”

ii. On the top-middle section of the screen, click “Plate Set-Up”

followed by “View/Edit Plate”.

iii.Click “Spreadsheet View/Importer” on the upper right quadrant of

the screen. Wells can be named with unique identifiers for

Sample Name, Sample Type, etc.

5. When CFX96 TouchTM run is completed, threshold setting update will need to be completed
as follows:

a. Open the “Data Analysis” window for your specific run
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel and

Quasar 670-channel and be sure “FAM” is checked (Note: Threshold adjustments
can be performed only in single threshold mode, be sure only one dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
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ii.At the bottom of the popup window under “single threshold”, select “User
Defined” and enter “500”

iii.Click “OK” and the threshold for FAM will apply to the experiment.
c. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel and

Quasar 670-channel and be sure “CalRed 610” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure only one
dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select “User

Defined” and enter “500”
iii.Click “OK” and the threshold for CalRed 610 will apply to the experiment

d. To apply threshold settings for Quasar 670-channel, uncheck FAM-channel and
CalRed 610-channel and be sure “Quasar 670” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure only one
dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select “User

Defined” and enter “500”
iii.Click “OK” and the threshold for Quasar 670 will apply to the experiment

6. Refer to Table 2 for result interpretation.
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Bio-Rad CFX96 TouchTM - Thermocycling Programing

Pooling - Direct Pooled Patient Sample (40 μL reaction volume)

Please refer to the following steps for CFX96 TouchTMmanual programming specific for Direct
Patient sample testing.

1. Launch the CFX Maestro software.

2. Select “File”, then choose “New” and select “Protocol”

3. Program thermocycling conditions in the Protocol Editor
a. Set Sample Volume to 40 μL
b. Click “Insert Step” to add a total of five total steps and program as follows (Table C1):
c. Step 1

i. Temp: 46°C
ii. Time: 20:00

d. Step 2
i. Temp: 95°C
ii. Time: 5:00

e. Step 3
i. Temp: 95°C
ii. Time: 0:03

f. Step 4
i. Temp: 62°C
ii. Time: 0:20
iii. Click “Add Plate Read to Step”. Also, ensure this is the only step containing a
plate read

g. Step 5
i. Temp: 70°C
ii. Time: 0:05

h. Step 6
i. Click to highlight “GOTO” and enter “3” to indicate thermocycling
includes Step 3, Step 4 and Step 5.
ii. At “GOTO 3”, confirm “39 more times” is programmed for a total of 40 cycles.

I. Save the new cycling conditions as protocol for future use
i. At the upper left of the screen select the Save button
ii. Save in the ExpressLoad folder
iii. Name the file ‘500003XMPDirectPooledCFX96Rev01’
iv. Save as type ‘Protocol File (*.prcl)’
v. Select Save
vi. Click Ok in the protocol editor window

4. Define the plate setup
a. Select “File” then choose “New” and select “Plate”
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b. In the Plate Editor, click settings and ensure your settings are as follows
i. Plate Size: 96 wells
ii. Plate Type: BR White OR BR Clear (BioGX recommends BR White)

c. Highlight all wells and choose “Select Fluorophores”
i. Uncheck all currently selected wells and check ONLY the following: FAM, Cal Red
610, Quasar 670

d. For “Sample Type” select “Unknown”
e. Check the boxes besides all three of your selected fluorophores. Change the

target name as follows:
i. FAM: RNaseP
ii. Cal Red 610: N1
iii. Quasar 670: IAC

f. Save the new plate setup for future use
i. At the upper left of the screen select ”File” then select “Save”
iii. Name the file ‘500003XMPDirectPooledCFX96PlateRev01’
iv. Save as type ‘Plate File (*.pltd)’
v. Select Save
vi. Click Ok in the Plate Editor window

g. Saving Protocol
i. Select “File” then “Open”
ii. Select “Protocol” then open your saved protocol.
ii. Ensure the PCR steps are correct and click “OK”
iii. Click the “Plate” tab and choose “Select Existing”. Choose the
plate that was saved.
iv. Add any desired notes and click on the “Start Run” tab.
v. Save the run with the desired name

h. Assigning a sample name to well positions
Once the run has begun, reaction wells can be assigned with a unique sample

name as follows:

i. Navigate to “Real Time Status”

ii. On the top-middle section of the screen, click “Plate Set-Up”

followed by “View/Edit Plate”.

iii.Click “Spreadsheet View/Importer” on the upper right quadrant of

the screen. Wells can be named with unique identifiers for

Sample Name, Sample Type, etc.

5. When CFX96 TouchTM run is completed, threshold setting update will need to be completed
as follows:

a. Open the “Data Analysis” window for your specific run
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel and

Quasar 670-channel and be sure “FAM” is checked (Note: Threshold adjustments
can be performed only in single threshold mode, be sure only one dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
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ii.At the bottom of the popup window under “single threshold”, select “User
Defined” and enter “500”

iii.Click “OK” and the threshold for FAM will apply to the experiment.
d. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel and

Quasar 670-channel and be sure “CalRed 610” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure only one
dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select “User

Defined” and enter “500”
iii.Click “OK” and the threshold for CalRed 610 will apply to the experiment

e. To apply threshold settings for Quasar 670-channel, uncheck FAM-channel and
CalRed 610-channel and be sure “Quasar 670” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure only one
dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select “User

Defined” and enter “500”
iii.Click “OK” and the threshold for Quasar 670 will apply to the experiment

6.  Refer to Table 2 for result interpretation.
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APPENDIX D

Bio-Rad CFX384 TouchTM - Thermocycling Programing

Direct Patient Sample (20 μL reaction volume)

Please refer to the following steps for CFX384 TouchTM manual programming specific for Direct
Patient sample testing.

1. Launch the CFX Maestro software.

2. Select “File”, then choose “New” and select “Protocol”

3. Program thermocycling conditions in the Protocol Editor
a. Set Sample Volume to 20 μL
b. Click “Insert Step” to add a total of five total steps and program as follows (Table D1):
c. Step 1

i. Temp: 46°C
ii. Time: 20:00

d. Step 2
i. Temp: 95°C
ii. Time: 5:00

e. Step 3
i. Temp: 95°C
ii. Time: 0:03

f. Step 4
i. Temp: 62°C
ii. Time: 0:20
iii. Click “Add Plate Read to Step”. Also, ensure this is the only step containing a
plate read

g. Step 5
i. Temp: 70°C
ii. Time: 0:05

h. Step 6
i. Click to highlight “GOTO” and enter “3” to indicate thermocycling
includes Step 3, Step 4 and Step 5.
ii. At “GOTO 3”, confirm “39 more times” is programmed for a total of 40 cycles.

I. Save the new cycling conditions as protocol for future use
i. At the upper left of the screen select the Save button
ii. Save in the ExpressLoad folder
iii. Name the file ‘500003XMPDirectCFX384’
iv. Save as type ‘Protocol File (*.prcl)’
v. Select Save
vi. Click Ok in the protocol editor window
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Table D1. CFX384 TouchTM thermocycling summary - Direct Patient Sample.

PCR Cycle Summary

Hold Stage PCR Stage

Conditions Step 1 Step 2 Step 1 Step 2 Step 3

Temperature (°C/s) 46 95 95 62 70

Duration (Min:sec) 20:00 5:00 0:03 0:20 0:05

Detection OFF OFF OFF ON OFF

No. of PCR Cycles HOLD HOLD 40

4. Define the plate setup
a. Select “File” then choose “New” and select “Plate”
b. In the Plate Editor, click settings and ensure your settings are as follows

i. Plate Size: 384 well
ii. Plate Type: BR White OR BR Clear (BioGX recommends BR White)

c. Highlight all wells and choose “Select Fluorophores”
i. Uncheck all currently selected wells and check ONLY the following: FAM, Cal Red
610, Quasar 670

d. For “Sample Type” select “Unknown”
e. Check the boxes besides all three of your selected fluorophores. Change the

target name as follows:
i. FAM: RNaseP
ii. Cal Red 610: N1
iii. Quasar 670: IAC

f. Save the new plate setup for future use
i. At the upper left of the screen select ”File” then select “Save”
iii. Name the file ‘500003XMPDirect_plateCFX384’
iv. Save as type ‘Plate File (*.pltd)’
v. Select Save
vi. Click Ok in the Plate Editor window

g. Saving Protocol
i. Select “File” then “Open”
ii. Select “Protocol” then open your saved protocol.
ii. Ensure the PCR steps are correct and click “OK”
iii. Click the “Plate” tab and choose “Select Existing”. Choose the
plate that was saved.
iv. Add any desired notes and click on the “Start Run” tab.
v. Save the run with the desired name

h. Assigning a sample name to well positions
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Once the run has begun, reaction wells can be assigned with a unique sample

name as follows:

i. Navigate to “Real Time Status”

ii. On the top-middle section of the screen, click “Plate Set-Up”

followed by “View/Edit Plate”.

iii.Click “Spreadsheet View/Importer” on the upper right quadrant of

the screen. Wells can be named with unique identifiers for

Sample Name, Sample Type, etc.

5. When CFX96 TouchTM run is completed, threshold setting update will need to be completed
as follows:

a. Open the “Data Analysis” window for your specific run
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel and

Quasar 670-channel and be sure “FAM” is checked (Note: Threshold adjustments
can be performed only in single threshold mode, be sure only one dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select “User

Defined” and enter “500”
iii.Click “OK” and the threshold for FAM will apply to the experiment.

e. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel and
Quasar 670-channel and be sure “CalRed 610” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure only one
dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select “User

Defined” and enter “500”
iii.Click “OK” and the threshold for CalRed 610 will apply to the experiment

f. To apply threshold settings for Quasar 670-channel, uncheck FAM-channel and
CalRed 610-channel and be sure “Quasar 670” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure only one
dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select “User

Defined” and enter “500”
iii.Click “OK” and the threshold for Quasar 670 will apply to the experiment

6. Refer to Table 2 for result interpretation.
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Bio-Rad CFX384 TouchTM - Thermocycling Programing

Extracted Patient Sample (15 μL reaction volume)

Please refer to the following steps for CFX384 TouchTM manual programming specific for
Extracted Patient sample testing.

1. Launch the CFX Maestro software.

2. Choose “File”, then choose “New” and select “Protocol”

3. Program thermocycling conditions in the Protocol Editor
a. Set Sample Volume to 15 μL
b. Click “Insert Step” to add a total of five total steps and program as follows (Table D1):
c. Step 1

i. Temp: 46°C
ii. Time: 20:00

d. Step 2
i. Temp: 95°C
ii. Time: 5:00

e. Step 3
i. Temp: 95°C
ii. Time: 0:03

f. Step 4
i. Temp: 62°C
ii. Time: 0:20
iii. Click “Add Plate Read to Step”. Also, ensure this is the only step containing a
plate read

g. Step 5
i. Temp: 70°C
ii. Time: 0:05

h. Step 6
i. Click to highlight “GOTO” and enter “3” to indicate thermocycling
includes Step 3, Step 4 and Step 5.
ii. At “GOTO 3”, confirm “39 more times” is programmed for a total of 40 cycles.

i. Save the new cycling conditions as a protocol for future use
i. At the upper left of the screen select the Save button
ii. Save in the ExpressLoad folder
iii. Name the file ‘500003XMPExtractCFX384’
iv. Save as type ‘Protocol File (*.prcl)’
v. Select Save
vi. Click Ok in the protocol editor window

4. Define the plate setup
a. Select “File” then choose “New” and select “Plate”
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b. In the Plate Editor, click settings and ensure your settings are as follows
i. Plate Size: 384 well
ii. Plate Type: BR White OR BR Clear (BioGX recommends BR White)

c. Highlight all wells and choose “Select Fluorophores”
i. Uncheck all currently selected wells and check ONLY the following: FAM, Cal Red
610, Quasar 670

d. For “Sample Type” select “Unknown”
e. Check the boxes besides all three of your selected fluorophores. Change the

target name as follows:
i. FAM: RNaseP
ii. CalRed 610: N1
iii.: Quasar 670: IAC

f. Save the new plate setup for future use
i. At the upper left of the screen select ”File” then select “Save”
iii. Name the file “500003XMPExtract_plateCFX384”.
iv. Ensure it is saved in the “*.pltd” format
v. Select Save
vi. Click Ok in the Plate Editor window

g. Saving Protocol
i. Select “File” then “Open”
ii. Select “Protocol” then open your saved protocol.
ii. Ensure the PCR steps are correct and click “OK”
iii. Click the “Plate” tab and choose “Select Existing”. Choose the
plate that was saved.
iv. Add any desired notes and click on the “Start Run” tab.
v. Save the run with the desired name

h. Assigning a sample name to well positions
Once the run has begun, reaction wells can be assigned with a unique sample

name as follows:

i. Navigate to “Real Time Status”

ii. On the top-middle section of the screen, click “Plate Set-Up”

followed by “View/Edit Plate”.

iii.Click “Spreadsheet View/Importer” on the upper right quadrant of

the screen. Wells can be named with unique identifiers for

Sample Name, Sample Type, etc.

5. When CFX96 TouchTM run is completed, threshold setting update will need to be completed
as follows:

a. Open the “Data Analysis” window for your specific run
b. To apply threshold settings for FAM-channel, uncheck CalRed 610-channel and

Quasar 670-channel and be sure “FAM” is checked (Note: Threshold adjustments
can be performed only in single threshold mode, be sure only one dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
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ii.At the bottom of the popup window under “single threshold”, select “User
Defined” and enter “500”

iii.Click “OK” and the threshold for FAM will apply to the experiment.
d. To apply threshold settings for CalRed 610-channel, uncheck FAM-channel and

Quasar 670-channel and be sure “CalRed 610” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure only one
dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select “User

Defined” and enter “500”
iii.Click “OK” and the threshold for CalRed 610 will apply to the experiment

e. To apply threshold settings for Quasar 670-channel, uncheck FAM-channel and
CalRed 610-channel and be sure “Quasar 670” is checked (Note: Threshold
adjustments can be performed only in single threshold mode, be sure only one
dye is selected)
i.Navigate to “Settings” and select “Baseline Threshold”
ii.At the bottom of the popup window under “single threshold”, select “User

Defined” and enter “500”
iii.Click “OK” and the threshold for Quasar 670 will apply to the experiment

6. Refer to Table 2 for result interpretation.
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REVISION HISTORY

Revision Date Description of Change

04 01APR2021

Update number of reactions (tests) per tube to number of
reactions (tests) per kit. Update Table 2 to simplify interpretation,
Update to add direct analysis of pooled patient sample, validated
real-time PCR instruments compatible with sample types, number
of tests per sample type, pooled sample set up, pooled LoD
summary, Appendix A and Appendix C.

03 10 FEB 2021

Update fluorophore utilized for IAC detection, addition of
nasopharyngeal wash/aspirates and nasal aspirate sample types,
addition of Applied BioSystems 7500 Fast Dx and Bio-Rad CFX384
Touch platforms, update BioGX Rehydration Water Part number to
800-0035-12, update use of Qiagen Viral RNA Mini Kit, update
comparator method (LineaTM COVID-19 assay), update clinical
concordance study.

02 18 NOV 2020

Update equipment and materials required but not provided
section, Update specimen preparation section, update positive
control and patient result interpretation, update limit of detection
table, update clinical performance, update reference section

01 09 OCT 2020 Initial Release
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SYMBOLS

Symbol Meaning

Catalog number

CE mark of conformity

���[���p�Q�j�g�] diagnostic medical device

Do not reuse

Batch code

Caution

Consult instructions for use

Manufacturer

Contains sufficient for <n> tests

Temperature limitation

Keep dry

Keep away from sunlight

Expiration date

Biological Risks

Control

1500 1st Ave. North, Suite C123, Birmingham, AL, USA
Phone: +1.205.250.8055
Fax: +1.205.449.8055
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